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 Project description

Course Number: BME 402

 

Project Name: Tissue Model of the Epithelial Mesenchymal Trophic Unit

 

Short Name: Tissue Model

 

Project description/problem statement: A multitude of chronic lung diseases such as pulmonary fibrosis, asthma, and chronic obstructive pulmonary
disease (COPD) can cause damage to epithelial tissues of the lungs. This presents a problem because when this tissue is damaged, a fibrotic
response is triggered in sub-epithelial fibroblasts that results in further disease and fibrosis. There are currently no tissue models that accurately
recreate the lung extracellular matrix and its changes due to cell injury. Such a model would need to have tunable mechanical stiffness and porosity, as
well as be cell adhesive and degradable. Dr. Brasier of the UW School of Medicine and Public Health requires a scaffold that meets these criteria to be
fabricated with a bioprinter. The scaffold must have a uniform and replicable composition that allows for epithelial cell culture in an air-liquid-interface
(ALI) so that his lab can study the effects of fibrosis on small-airway lung epithelial cells.

 

About the client: Dr. Allan Brasier is the Executive Director of the UW-Madison Institute for Clinical and Translational Research. His research focuses
on the inflammation and its role in advancing pulmonary and cardiovascular disease.

 

Nick Herbst - Jan 26, 2024, 4:26 PM CST
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 01/25/2024 Advisor Meeting
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Title: January 25th Advisor Meeting 

Date: January 25th 2024

Content by: William Onuscheck

Present: Team, Dr. Tracy Puccinelli

Goals: To establish goals for the semester

Content: 

Set up regular meeting schedule with client.

The main 402 difference is a journal article in addition to the standard report.

Standard report and journal article can / will be similar

Planning presentation rather than preliminary presentation

Similar to what we did in the Fall since we went off of 402 guideline

Only with advisor

Informal

“Very detailed plan”

Some rubric items may not be applicable

Add other things that are relevant

Soft 10 min

Do things concurrently while working on presentation

Journal article

Identify appropriate journal

Look at journals where we have been pulling our resources from

Shoot for a moderate impact factor (3 - 6 range)

Option to submit if motivated

New progress report

To reflect industry level of detail

Current protocols (lead with up front) rather than drawings

More detailed timeline

Gantt chart 

Show and tell 

Going to give advice to 300 level 

Reschedule advisor meeting with full team if conflicts come up 

Feb 16

Feb 23

Mar 22

Methodical staining and viewing

WILLIAM ONUSCHECK - Jan 30, 2024, 12:24 PM CST
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Use the Nikon

Body temperature rheometry testing 

May want to look into making a new protocol on the rheometer to bypass the 5 minute normal force test

Methodical

Dry weight for swelling

Conclusions/action items:

Begin working on preliminary presentation. Find literature supporting drying times for swelling ratio. 

 

Loading [MathJax]/extensions/Safe.js
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 02/02/2024 Advisor Meeting

Title: Advisor Meeting

Date: 02/02/2024

Content by: Nick Herbst

Present: Team, Prof. Puccinelli

Goals: Update advisor on weekly activities 

Content:

Told advisor about rheometry of pipette-based hydrogels
Rheometer plate missing so found a substitute that thought would work but stiffness came out very very low

Likely due to equipment issues (wrong plate or installed improperly)
Need to reach out to someone to talk about set up
Dr. P says that the plates were scratched and the coolant fluid was low

Wet weight of pipette-based hydrogels went down from the pre-swelling weight
Very strange since this should not have happened
Either errors with pre-weighing or errors with wet weight

using wipe to remove surface water possibly could have been too forceful but unlikely
Told advisor that we set up meetings for bioprinter demo and for client meeting

Conclusions/action items:

Re-make new pipette-based gels and do rheometry testing and weighing 
Look for rheometer manual and for the normal head used
Before using it again, reach out to original graduate student who taught Elijah and/or reach out to a PI who regularly uses

Reorient with bioprinter 
Make bioprinted gels and do rheometry
Meet with the client to give demo on bioprinter
Work on preliminary presentation for next week

Nick Herbst - Feb 02, 2024, 12:30 PM CST
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 03/01/2024 Advisor Meeting

Title: Advisor Meeting

Date: 03/01/2024

Content by: Nick

Present: Nick, Carley, Anuraag, Elijah, Caitriona, Prof. Puccinelli

Goals: Update our advise on the current status of our project and begin to discuss preliminary deliverables

Content:

Cells look good
Need to email client the discussion notes from meeting that was missed on Thursday
Bioprinting went well last time, more extrusion vs dispensing, much better structure, stiffness is in between the ranges, going to go back
Sunday
Tong lecture in 2 weeks

Meet with advisor afterwards
Show and Tell is in 3 weeks

Meet in ECB atrium to advise 301 teams
If going to miss it, email Tracy to get put on list of people who will do Zoom advice with 301 teams

First comments on preliminary report
Really weird that biomaterials science doesn't have manuscript formatting requirements (spacing, font, etc.)
Tracy says typically in a manuscript you'd see all figures/tables at the end with captions, and that methods should be
before results

Action items:

Continue to work to meet project goals

Nick Herbst - Mar 01, 2024, 12:22 PM CST
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Title: GelMA bioprinting trial - with Brasier and Dianhua

Date: 2-7-2024

Content by: Elijah Diederich

Present: Carley, Elijah, Caitriona

Goals: To showed Dr. Brasier an introduction to the bioprinter and showcase our learning

Content:

Parameters that will stay the same:

- Infill density of 35%

- Dimensions 3 x 0.6mm (for 3D Structure print)

- UV crosslinking time - 30 seconds, 405nm, 4cm distance away

- Temp set at 37 degrees, waiting 30 min for GelMA to thaw 

- Pre-flow = -100 ms

 

Trial 1:Structure Print

- Print temperature: 29 degrees

- Extrusion Pressure: 22 kPa

** GelMa did not print during run ** --> Started to troubleshoot, unclogging etc.... brasier not impressed. Carley removed
the bubble with excess flicking of the dispensing nozzle.

Trial 2: Structure Print

Print temperature: 31 degrees

Extrusion Pressure: 24 kPa

*** GelMa also did not print during run *** 

Trial 3: Structure Print

Pre-flow delay: -130 ms

Print Temperature: 31 degrees

Extrusion Pressure: 22 kPa

**** GelMA not printing during run **** Attempted to do test flow, nothing happens @ 22 kPa

Went to 24 kPa, no extrusion achieved

Caitriona Treacy - Feb 14, 2024, 5:45 PM CST
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26kPa - No extrusion

28 kPa - No extrusion

After this, used a syringe (provided by Dr. Brasier) to potentially remove obstruction, no success.

Trial 4: Droplet Bioprinting test run - Switched to 6 well plate

Print Temperature: 30 degrees

Extrusion Pressure: 15 kPa

Extrusion time: 1sec

UV: 30sec, 405, 4 cm away

**  No pre-flow delay on the droplet bioprinting **

*** Recalibration needed because bioprinter is confused as to where the UV light and what well it is printing in ***

Droplet bioprinting also did not work

 

Trial 5: Back to Structure Based Bioprinting - Petri Dish

Pre-flow delay: -150 ms

Print temperature: 29 degrees

Extrusion Pressure: 25 kPa

*** No print achieved ***

** Test flow, achieved a blob on the petri - 35 kPa used for the test flow **

Bumped pressure down - 33 kPa and a large blob came out

Trial 6: Structure Based Bioprinting

Extrusion Pressure: 28 kPa

Temperature: 29 temperature 

Pre-flow delay: -150 ms

** Were able to achieve a printed structure **

Trial 7: Structure Based

Extrusion Pressure: 21 kPa

Temperature: 29 degrees

Pre-flow delay: -150 ms

Trial 8: Structure Based 
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Extrusion Pressure: 23 kPa

Temperature: 29 degrees

***Structure Printed***

Conclusions/action items:

1. Do rheology on bioprinted gels (placed in incubator)

2. Practice final presentation for Friday

Team activities/Client Meetings/2-7-2024 - WIMR Meeting 13 of 149



 02/13/2024 Client Meeting

Title: Client Meeting

Date: 02/17/2024

Content by: William

Present: Elijah 

Goals: Establish the need for communication with field science, and establish a rationale for caclien use

Content:

Response from tech support: Check in of equipment virtually at thursday at 11, detect remotely,
check for internet connection on printer for software, have GelMA warmed up for remote testing.
Details forwarded to Carley. 
Ordering new GelMA cartridges, for
Rheology testing, gels in the fibrotic range, kPa, consistency, soft gels have already been
produced. Explanation of X-Linking. Increase throughput. 
Calcein staining approved, follow up with sending ordering link.  

Action items:

Work on preliminary deliverables

WILLIAM ONUSCHECK - Feb 27, 2024, 3:34 PM CST
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Title: Cellink Troubleshooting Meeting 

Date: 2-15-24

Content by: Caitriona and Elijah

Present: Carley, Elijah, Caitriona, Will

Goals: To meet with the client as well as representatives from Cellink to further Troubleshoot the bioprinting process
with GelMA

Content:

- Suggested to preflow delay -100 ms and heating to 37˚ in an exterior waterbath for 5-10 minutes while also
maintaining 37˚ temperature in the temperature controlled printhead. 

- 22-27 kPa. There will be +/-

- Bottom row cannot be printed because of door interference with temperature controlled printhead. With 6-well plate,
you need to rotate.

- Photocrosslinking print head gets closer.  

- Distance between the wells. Turn inside lights off inside to avoid ambient light effects. Manual moving.

- This material is very sensitive to temperature changes; a 0.3˚ temperature difference changes print when working with
GelMA. 27 guage can help with structural integrity. Always test flow before doing a print. 

1. Turn light off

2. Put well plate inside 

3. Print for first 3 well plates and then can go to the move command (move UV to on top of back left well plate)

4. Go to tools--> modules--> Turn on UV at 405 nm

5. Use calipers to measure distance from UV module to plate

Test Print w/ GelMA using protocol that we have:

1. Preloaded protocol

- Change light to 20%

- Extrusion: 

-Pre-flow:

- Diameter 6mm

Caitriona Treacy - Feb 19, 2024, 10:10 AM CST
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*** Use 27g instead of 22g so that there can be a more precise construct ***

Ambient light = Clogging; that is why we turned it down to 20%

- Changed to 10 seconds of UV light just for demo purposes 

-Pre-flow @ -100ms

- Temperature kept at 27 degrees celcius

- Extrusion pressure: 40 kPa

2. Went to layers --> Preview (zoomed in) **Said construct shouldn't fill in at these settings,** said we should change
pressure and temp for better printability.

3. Kimwipe under nozzle, changed to 32 kPa and clicked on extrude, 33kPa, nothing extruded, 34kPa nothing, 35 kPa
nothing, 36 kPa nothing. Declogged and then it came out.

4. 35 kPa worked, 34 kPa worked, 33 kPa worked (very watery at these pressures, too high) kept here @ went to 25
degrees celcius (thinks it is a temperature issue). Should be integrity to construct coming out of the nozzle. Waited for
the temperature to go down. Wait 3–5 minutes for homogeneity temperature change. 0.3 degree change to where it
changes from gel to watery fluid. GelMA will slightly change during these settings (no more than 10%)

5. Once the temperature reached 26 degrees celcius, did a test flow. Still at 33 kPa (nothing out). 34 kPa nothing, 35
kPa (strarting to extrude), 36 kPa (didn't come out), 37 kPa (nothing), 38 kPa-40 (nothing came out). Went to 26.5
degrees celcius for temperature. Should be between 26–27 degrees, determined by steps above. 

6. At 26.5 degrees, declogged nozzle and then went to 33 kPa (comes out). GelMA comes out like a gel, but field
scientist said it was too liquid. Went to 26.3 degrees Celsius. Wants the GelMA to come out like a filament. We're
dispensing material (not extruding it) with previous trials. 

- Rounding on top --> initial calibration (go down 300 microns instead of 400 microns) - Flat surface 

7. Unclogged and then tried to extrude at 33 kPa (watery), 30 kPa (extruded), 31 kPa (still runny). Went down to 26.1
degrees celcius. 30 kPa (liquid). Went to 25.5 degrees Celsius. ***25.7-26.5 degrees Celsius is ideal for GelMA***

8. Unclogged at then went to 30 kPa (more gel like) very promising, 32 kPa (very gel like). 34kPa too high. Declogged
33 kPa (gel like), 34 kPa (gel like but a bit more watery)

9. 35 kPa test print, still at 25.5 degrees Celsius. Test print. Idea to start going from low temp and low pressure to
minimize wasting material. Then did calibration. Automatic and manual. 

Team activities/Client Meetings/2-15-2024 - CELLINK Meeting 17 of 149



10. Doing manual, unscrewed the syringe so it could move up and down. Went to center of well that we are going to
print in. Tightened knob. Using 22 guage, move down 400 microns and then clicked calibrate. 25 guage - 300 microns -
27 gauge - 250 microns.

11. After calibration, went to extrude (35 kPa) - nothing, 36 kPa - nothing. Clogged, so went to calibrate and went 1.5
mm down twice (3mm) so that we had access to nozzle to unclog. Went back up 3mm. Did a manual recalibration and
just fixed Z-Axis calibration. Then moved down 400 microns --> Calibration acheived.

12. Test extrude at 36 kPa (came out), big delay. 37 kPa (better, but curling around tip), 38 Kpa (curling). 39 Kpa - Test
print - Nothing extruded. Went to speed of 8 mm/s for tool 2 speed (8-14 mm/s) good range. 40 kPa - test extrusion
(curling around tip).

14. Increased temperature to 25.7 degrees celcius and 42 kPa. Waited one minute. Test print - Looks much better, but
not great?. Curling around nozzle. 45 kPa - collecting at top of nozzle. Tried again, same result. Went to 47 kPa -
curled. 50 kPa - curled around nozzle. Field scientist said that consistency was good though. 50 kPa - curled. 55 kPa -
looked fantastic. 57 kPa (curled). 60 kPa (still curling). Curling of filament means pressure is too high and
expanding in all direction.

15. Test Print - 60 kPa, increased temp to 25.8 degrees Celsius. Results:  3 structures were printed (one in each well).
Note: UV calibration was very good. Better diameter - ideal in #2. Need to optimize pressure and use a 27 gauge
needle. Also, decreasing the speed can also help to keep material steady in the tube. If decreasing speed, decrease
pressure. If increasing speed, increase pressure.

Need to optimize printing parameters such as pressure and speed. Temperature range should be optimized,
though. Higher molecular weight GelMA's are better for printing, but have worse cell attachment. 

****Low speed is always good****

Material sterility practices: Will asked someone in production team and fill in team via email. Storing GelMA in
biosafety cabinet and bringing out. 

Using bacterial hood, could move bioprinter so that it would be in a clean environment. 

- Better way to solve clogging: 2 syringes in a water bath and use thin needle

*** Delay can be fixed if we add in G code ***, these preflow delays come into play too. Change with these or can code.

** Dr. Brasier mentioned that he wants size to be in a 12 well plate to fit ALI. **

Team activities/Client Meetings/2-15-2024 - CELLINK Meeting 18 of 149



Conclusions/action items:

1. Do rheology on bioprinted gels (placed in incubator)

2. Practice final presentation for Friday

Team activities/Client Meetings/2-15-2024 - CELLINK Meeting 19 of 149



 02/27/2024 Client Meeting

Title: Client Meeting

Date: 02/27/2024

Content by: Nick

Present: Nick, Anuraag, Dr. Brasier

Goals: Update client on current status of the project

Content:

Discussion Plan
Told Dr. Brasier that bioprinting is going better after starting to implement the advice from the field scientist

Better printed structure (flat rather than globs)
Higher variability but getting better

Want to soon do epithelial cell culture on gel surface (end of this week/beginning of next week)
To reduce contamination can the bioprinter be moved closer to BSC?

other idea would be to just cover printed dish when moving and clean entire interior of
bioprinter with 70% ethanol between uses

​Does Dianhua have flask of epithelial cells going and if not then can that get started?
planning on printing gels for him Friday or Sunday for him to seed cells on Monday

Currently working on our preliminary report
Dr. Brasier notified team last minute about a conflict so he couldn't make it to the meeting

This discussion plan was communicated to the client via email

Action items:

Work on preliminary deliverables

Nick Herbst - Feb 27, 2024, 12:02 PM CST
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 03/12/2024 Client Meeting

Title: Client Meeting

Date: 03/12/2024

Content by: Nick

Present: Nick, Anuraag, Elijah, Dr. Brasier

Goals: Update client on current status of the project

Content:

Asked about status of materials that Dianhua ordered
LIVE/DEAD Cell Viability Kit was ordered 2 weeks ago, no news from Thermofisher on order status
3 new GelMA bioink cartridges were requested 3 weeks ago but Dianhua missed an email from CELLINK so the order was
not actually placed until now

Updated client on status of bioprinting trials
Attempting to make thicker hydrogels
Dr. Brasier said that Dianhua showed him the seeded bioprinted gels and it appeared as goo
Dr. Brasier suggested that Dianhua add an MMP-inhibitor when he seeds the epithelial cells if the thicker hydrogels still
"melt"

Asked if Dianhua could take pictures of the hydrogels seeded with epithelial cells regardless of how they turned out
We need the images for our deliverables

Dr. Brasier said that CELLINK field scientist says that GelMA bioink is their most "finnicky" bioinks and he mentioned possibly switching
off of GelMA

At this point we can't do that

Action items:

Troubleshoot LIVE/DEAD staining

Nick Herbst - Mar 12, 2024, 12:16 PM CDT
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 02/09/2024 Product Design Specifications

Title: Product Design Specifications

Date: 02/09/2023

Content by: Everyone

Present: Everyone

Goals: Update the PDS

Content:

- We need to update the PDS from last semester

- See the attached file for the full PDS

Action items:

- Work on preliminary deliverables

Nick Herbst - Feb 28, 2024, 1:27 PM CST

Download

BME_402_PDS.pdf (221 kB)

Nick Herbst - Feb 28, 2024, 1:28 PM CST
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Title: Design of Troubleshooted Live Dead Staining

Date: March 13, 2024

Content by: William 

Present: William 

Goals: To establish what methods could be changed to obtain live / dead images that are not washed out

Content:

On March 4th, 2024, an initial batch of cell laden hydrogels were fabricated for the purpose of validating the live dead staining protocol. Last semester, there was an issue

where imaging under the FITC filter was resulting in completely washed out images. Brightfield image of these cells indicated that cells were indeed, imbedded in the gels,

and although not super fibroblastic in their morphology, were in tact, and should be staining as live or dead:

This image from March 4th is representative of that. LIVE/DEAD staining was performed on these March 4th gels using .53 µM calcien-AM and 2 µM ethidium homodimer

which are concentration in line with both the literature and the manufacturer's recommendation's. 3 washes were performed consecutively using PBS. Of note, the March 4th

gels were not allowed to rest in the PBS wash, and a pink hue from their culture media persisted through the washes. The March 4th gels were then treated with the staining

solution, and allowed to incubate at room temperature for 30 minutes. The LIVE/DEAD images from the gels fabricated on March 4th, stained on March 5th were still (staining

occurred on march 5th) remained washed out:

https://drive.google.com/file/d/19EoH5ZSseY0wllor_wi_iBRyXLR8k64F/view?usp=drive_link

↑ Link to video of washed out gels, LabArchives does not support insertion of non-URL video. 

From this, there was that esterases were persisting in the extracellular space of the gels, resulting in the cleaving of calcien-AM into calcien, enabling its fluorescence. The

following variables were identified as variables which may improve the imaging quality: an increased number of PBS washes, increased PBS wash time, and decreased

incubation time in staining solution. 

In an effort to troubleshoot using these variables the gels fabricated on march 12th (LIVE/DEAD imaged on March 13th) were split into two groups. One group would be

incubated for 15 minutes in the staining solution, and one group would be incubated for 30 minutes in the staining solution. Both groups would be washed 5 times, being

allowed to sit in the wash for 5 minutes. We figured that longer wash times could not hurt. 

WILLIAM ONUSCHECK - May 01, 2024, 10:44 AM CDT
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Both groups that were incubated for 15 and 30 minutes yielded fairly clear images, and we concluded that the number of washes and the incubation time in wash were

responsible for improved imaging. 

Conclusions/action items:

Fabricate a batch of cell laden gels for final imaging over a longer period of time (2 weeks). Moving forward, wash gels 5x for 5 minutes prior to LIVE/DEAD imaging. Update

imaging protocol to reflect this change. 
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 02/27/2024 Preliminary Materials List

Title: Preliminary Materials List

Date: 02/27/2024

Content by: Nick

Present: Nick

Goals: List current materials and expenses

Content:

See attached spreadsheet for materials list

Conclusions/action items:

work on preliminary deliverables

Nick Herbst - Feb 27, 2024, 11:12 AM CST
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402_Materials_-_Sheet1.pdf (62.4 kB)
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 01_30_2024PipetteGelMaking

Title: Making GelMA Hydrogels for Initial Rheometry and Swelling Tests

Date: 01/30/2024

Content by: Anuraag Belavadi

Present: Anuraag, Will

Goals: 

Content:

 

Conclusions/action items:

 

ANURAAG SHREEKANTH BELAVADI - Jan 30, 2024, 12:35 PM CST
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Title: Bioprinter protocol (extreme detail)

Date: 01/30/24

Content by: Carley Schwartz

Present: Self

Goals: To create a very detailed protocol for other group members

Content:

Materials:
1. GelMA in amber cartridge from fridge
2. CELLINK Bioprinter
2a. Temperature controlled printhead attachment
2b. Temperature maintaining nozzle attachment
3. 22 gauge nozzle attached to cartridge (Many incase of clog)
3a. Smallest needle for declogging
4. Pressure hose
5. Luer lock connections
6. Petri dish

Method:
1. Place the GelMA cartridge into the connected temperature controlled print head
2. On the bioprinter interface select the type of print you would like to conduct, in our
scenario we will be doing a structured print
2a. Go to bioprint -> Simple shapes -> scroll down to cylindrical and select the
3x06mm.stl
2b. Go to surface -> select your surface (for us petri dish)
2c. Printer -> tool 1 (or whichever you are using/what the print head is connected to)
-> tool type: temperature controlled ; temperature: 37 degrees to make a liquid
2d. At this point place the GelMA cartridge with a 22 gauge nozzle and the
tube attached to the machine
2e. Once the time has passed pull the cartridge out and move it up and down
to make sure it is a liquid
2f. Bioink profile: Cellink GelMA 1
2g. Pre-flow: -100 ms
2h. Photocrosslinking: 405 nm
3. Layers
3a. Select concentric for infill pattern
3b. For infill density select 35%
4. On the Print screen
4a. Press the settings symbol and go to Tools - for temperature change to printing
temp (27) and wait for 15 minutes for it to equilibrate
5. Once in the print screen -> go to the print option which will then take you to calibration
6. Calibrate first with be leveling and the probe in the back
7. Next manual calibration to provide the printer information on how far you want the
nozzle to be from the dish while printing and in what region of the dish
7a. UV light requires it to be in the back half
8. Now the machine should be ready to print but you should check to make sure there are no
bubbles in the cartridge nozzle by flicking and make sure the tip isn't clog with one of the
cell link needles
9. Then you press start to do the print trial
9a. If issues arise adjust the temperature, extrusion pressure, unclog the nozzle or
flick the tube
9b. If continual issues you can test the extrusion pressure with test flow but avoid
doing this as it wastes a lot of product!!!

Conclusions/action items:

As the semester continues more details will be added based on UV time and distance for fibrotic and healthy states. 

Nick Herbst - Mar 08, 2024, 3:31 PM CST
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 02/02/2024 Bioprinting Trials 1

Title: Bioprinting Trial 1

Date: 02/02/2024

Content by: Caitríona 

Present: Everyone

Goals: Reorient ourselves on the bioprinter and establish concrete protocol

Content:

GelMA heated to 37˚ for 45 minutes. It was confirmed that the GelMA was liquid by removing the cartridge
and turning it side to side. The cartridge was put back into the temperature controlled printer head. The
temperature was then decreased to 27˚ and a 15-minute interval passed to allow the GelMA to undergo the
temperature change. 
Concentric cylindrical geometry, 3 mm diameter. Height of 0.6 mm. 35% infill density. 1 layer. UV time set to
50 sec. 405 nm UV wavelength. 
Successful test flow at 22 kPa. Nozzle de-clogging to remove stuck GelMA. 
First print unsuccessful - nothing came out. More de-clogging of the nozzle. 
Temperature increased to 28˚. Pressure increased to 25 kPa. Unsuccessful. 
Temperature maintained at 28˚. Pressure increased to 33 kPa. GelMA was too liquidy and the gels
exceeded the desired diameter. 
UV cross-linking time changed to 15 s. Nozzle replaced. Pressure adjusted to 36 kPa. Unsuccessful, no
GelMA was dispensed 
See attachment for pictures

Conclusions/action items: Two gels were printed successfully. Carley and Caitríona will return to WIMR on
Monday to conduct another bioprinting trial. 

Nick Herbst - Feb 28, 2024, 1:29 PM CST
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 02/05/2024 Pipette Based Hydrogel Fabrication

Title: 02/05/2024 Pipette Based Hydrogel Fabrication

Date: 02/05/2024 

Content by: Will

Present: Will

Goals: To fabricate non -cell laden hydrogels at healthy and fibrotic stiffness

Content:

9 full gels were produced at each stiffness condition from (950µL media, 50 µL LAP, and 50mg GelMA per batch).

3 min fridge, 5 min UV and 5 min fridge, 5 min UV were used for healthy and fibrotic gelling and swelling conditions. 

Post Fab masses were taken of four gels per condition.

8 Gels per condition were stored in 1 mL media at 37 °C.

1 Gel per condition were stored in media at 4 °C for the sake of "Validating" the rheometer when testing gels. 

Conclusions/action items:

 Perform rheology on gels, record 24H weight weight, allow gels to begin drying. 

WILLIAM ONUSCHECK - Feb 05, 2024, 2:05 PM CST
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Title: Bioprinting Trial 2

Date: 02/05/2024

Content by: Caitríona 

Present: Carley & Caitríona 

Goals: Fabricate bioprinted gels whose stiffness values can be tested tomorrow. 

Content:

GelMA heated to 37˚ for 30 minutes. GelMA cartridge removed to verify that GelMA was liquid before
decreasing the temperature to 27˚ and waiting 15 minutes. Constant cylinder dimensions of 3x0.6mm. 35%
infill density. UV crosslinking for 30 s at 405 nm wavelngth, 4 cm distance. 
Temperature 27˚. Pressure 25 kPa. Pre-flow delay 1000 ms. Print did not work. The printer tip was severely
clogged, so we switched to a new 22 gauge tip. 
Temperature increased to 37˚ for 3 minutes. Temperature decreased to 33˚ for 2 minutes. Pressure 27 kPa.
Pre-flow delay 1000 ms. Print did not work. GelMA is visibly liquid in the tip and seems ready to print.
Immediately followed this trial with the next one. 
Temperature 33˚. Pressure 25 kPa. Pre-flow delay 1000 ms. Print did not work.
Temperature 33˚. Pressure 32 kPa. Pre-flow delay 1000 ms. Print did not work. Declogged the tip using a
needle before the next trial, even though it seemed to be liquidated in the tip. 
Temperature 33˚. Pressure 32 kPa. Pre-flow delay 1000 ms. Print did not work.
Temperature 33˚. Pressure 32 kPa. Pre-flow delay 1000 ms. Print did not work. A possible faulty variable
could be that the Tool 1 of the printer is not applying pressure correctly. We switched the print head to Tool 2
which has a separate insertion point for the pressure tube of the temperature controlled print head. 
Temperature decreased to 29˚ for 4 minutes. Pressure 23 kPa. Pre-flow delay 1000 ms. Print did not work. 
Temperature 29˚. Pressure 35 kPa. Pre-flow delay 1000 ms. Print did not work. The tip was declogged using
a needle, despite no bubbles or obvious clogging. 
Temperature 29˚. Pressure 40 kPa. Pre-flow delay 1000 ms. Print did not work. Declogged. 
Temperature 29˚. Pressure 50 kPa. Pre-flow delay 1000 ms. Print did not work. Declogged. 
Temperature 29˚. Pressure 25 kPa. Pre-flow delay 2000 ms. Print did not work. Declogged. Checked to
verify that GelMA was, in fact, liquidated. 
Temperature 29˚. Pressure 35 kPa. Pre-flow delay 2000 ms. Print did not work. Declogged. 
Test flow at 25 kPa revealed that drop printing was functional. No issues with extrusion. Indicates that the
pressure source is working. 
Temperature 29˚. Pressure 25 kPa. Pre-flow delay 2000 ms. Print did not work. 
Switched from three-dimensional structure to droplet printing with extrusion time of 1.5 s. Temperature of
29˚. Pressure15 kPa. UV crosslinking time of 30s at 405nm wavelength.  

see attachments for photo 1
Too much material extruded during last trial. Still droplet printing. Temperature 29˚. Pressure 20 kPa. 0.75 s
extrusion. The drop that can be seen in the right-most gel was a drop that fell off of the printer tip, not an
additional print trial. UV crosslinking did not occur in the correct position.

see attachments for photo 2
Switched back to three-dimensional cylindrical structure printing. Temperature 29˚. Pressure 22 kPa. Pre-
flow delay 5000 ms. Print did not work. Gel could be seen liquidated in the tip prior to print attempt.
Declogged anyway. 
Temperature 29˚. Pressure 22 kPa. Pre-flow delay -5000 ms. Way too much GelMA was dispensed.
Cancelled the print as soon as we could. 

Nick Herbst - Feb 28, 2024, 1:47 PM CST
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Temperature 29˚. Pressure 22 kPa. Pre-flow delay -100 ms. Print did not work. Declogged. 
Temperature 28˚. Pressure 22 kPa. Pre-flow delay -100 ms. Dimensions too large. 

see attachments for photo 3
Temperature 26˚. Pressure 18 kPa. Pre-flow delay -100 ms. In the picture below, this new print is located to
the right of the previous print. Size is of more accurate dimensions. 

see attachments for photo 4

Temperature 26˚. Pressure 18 kPa. Pre-flow delay -100 ms. Print did not work. We noticed significant
bubbles. Took the cartridge out and flicked it to try to eliminate these before the next print. 
Temperature 26˚. Pressure 18 kPa. Pre-flow delay -100 ms. The resulting gel contained significant bubbles.
Nozzle replaced. see attachments for photo 5 showing the new print situated between the last two structures
(bubbles can be seen in this middle gel). 

Temperature 26˚. Pressure 18 kPa. Pre-flow delay -100 ms. Print did not work. 

Conclusions/action items: The three gels in the final photo will be transported to the ECB Teaching Lab so that
their stiffness can be tested in 24 hours. The main gel of interest is the gel with smaller dimensions and no
bubbles. This was considered our most successful print, and we need stiffness values so that UV crosslinking
time can be adjusted in future iterations with the same temperature and pressure values, 26˚ and 18 kPa,
respectively. 

Download
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Title: Bioprinting Trial 3

Date: 02/14/2024

Content by: Caitríona 

Present: Caitríona 

Goals: Fabricate bioprinted gels whose stiffness values can be tested tomorrow. 

Content:

Unchanged Parameters for this print trial: Cylinder dimensions of 3x0.6mm. 35% infill density. UV crosslinking for 30 s
at 405 nm wavelength, 4 cm distance.

GelMA heated to 37˚ for 30 minutes in temperature controlled printer head – tool 2. The cartridge was then
removed from the printer and vortexed for 1 minute on speed 1. The cartridge was returned to the
temperature-controlled printer head, where the heat was maintained at 37˚ for an additional 15 minutes.
Temperature reduced to 26˚ and the cartridge was left to sit for 15 minutes. Again, the cartridge was
removed from the printer and vortexed for 30 seconds on speed 1. 
Selected print setting. Calibrated. 
Temperature 26˚. Pressure 22 kPa. Pre-flow delay -100 ms. Print did not work. Declogged. 
Test flow (26˚ held constant):

20 kPa – Nothing
21 kPa – Success

Temperature 26˚. Pressure 21 kPa. Pre-flow delay -100 ms. Print did not work. 
Test flow at 22 kPa successful 

Temperature 26˚. Pressure 22 kPa. Pre-flow delay -200 ms. Print did not work. 
Test flow 25 kPa successful. Declogged

Temperature 26˚. Pressure 25 kPa. Pre-flow delay -300 ms. Print did not work. 
Temperature 26˚. Pressure 32 kPa. Pre-flow delay -400 ms. Print did not work. 
Temperature 26˚. Pressure 42 kPa. Pre-flow delay -400 ms. Print did not work, but a small drop of GelMA
came out, staying on the tip (~1 mm in diameter). The problem seems to be related to the GelMA being too
viscous and staying adhered to the GelMA in the cartridge. The temperature was increased to 29˚ for 5
minutes before attempting the next print. 
Temperature 29˚. Pressure 42 kPa. Pre-flow delay -400 ms. Print worked, but GelMA was too liquidy.
Printhead temperature was decreased to 27˚, and 5 minutes passed before declogging and conducting the
next print. 

see attachments for photo 1

Temperature 27˚. Pressure 42 kPa. Pre-flow delay -400 ms. Print was successful. Still larger than intended
dimensions. Extrusion pressure should be lower.

see attachments for photo 2

Temperature 27˚. Pressure 40 kPa. Pre-flow delay -400 ms. Print was successful. Dimensions still too large.
Decreasing the pre-flow delay should help. 

see attachments for photo 3

Temperature 27˚. Pressure 40 kPa. Pre-flow delay -300 ms. Print was successful, but again lacking the
correct structure.

See attachments for photo 4 

Nick Herbst - Feb 28, 2024, 1:41 PM CST
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See attachments for photo 5: Top-down photo included of all prints for size comparison and to show the lack
of cylindrical structure:

Note: Prints are shown in order, with print number 1 on the left and print number 4 on the far right. 

Conclusions/action items: Transport gels to ECB so that their stiffness values can be measured tomorrow.
Attend the virtual meeting with a Cellink representative tomorrow, Dr. Brasier, and a couple members of the
team. Today will serve as a documentation of the current state of the project.  
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 02/16/2024 Bioprinting Trials 4

Title: Bioprinting Trial 4

Date: 02/16/2024

Content by: Caitríona & Carl `

Present: Caitríona, Carley & Elijah

Goals: Fabricate bioprinted gels through the application of what was learned at the meeting with Cellink Bioprinting
Field Scientist yesterday. 

Content:

**Today's print attempt started using a 27G nozzle (instead of 22G). This means calibration height between nozzle and
printing surface was 250 microns. Infill density was therefore increased to 60%. Pre-flow delay of 100 ms. UV
crosslinking for 10 s at 405 nm wavelength, 4 cm separation. Printing surface was a 6 well plate. Speed at 8 mm/s for
all print trials. 

Printer overhead light reduced to 20%. GelMA cartridge placed in temperature controlled print head, set at 37˚ for 45
minutes. Temperature reduced to 25.8˚ and 15 minutes passed to allow for thorough cooling. 

Temperature 25.8˚. Pressure 60 kPa. The first print extruded well, but lacked shape. Infill density is too high,
started forming a second layer. The next two wells did not print, suspected clogging in the nozzle. We
switched to the original 22G nozzle. Specifications required re-calibration with nozzle size change; new
height between nozzle and printing surface 400 microns.
Temperature 25.8˚. Pressure 60 kPa. Infill density returned to 35%. All three prints were extruded, but again
there was a lack of structural integrity. Too much material being dispensed; need to reduce extrusion
pressure to be more compatible with the 8 mm/s print head speed. 
Temperature 25.8˚. Pressure 46 kPa. Infill density returned 35%. All three prints extruded, but the needle
was dragging in the material again, causing more structural variation. Too much material is dispensed, but
diameters are tiny. 
See attachment for photos

Now with our ability to form a structure that does not lose shape and extrude outward we will be trying a larger size
cylinder: 10 mm diameter with 1 mm thickness (10x1) all previous parameters will be maintained.  

Temperature 25.8˚. Pressure 60 kPa. Small portions of GelMA were extruded but lacked structure, ran out of
GelMA on the print.

Conclusions/action items: Four gels were extruded that can be tested tomorrow for stiffness values (10 second
crosslinking time). 

Nick Herbst - Feb 28, 2024, 1:36 PM CST
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 02/21/2024 Bioprinting Trials 5

Title: Bioprinting Trial 5

Date: 02/21/2024

Content by: Caitríona

Present: Carley & Caitríona 

Goals: Fabricate bioprinted gels. 

Content:

**Today's print attempt used a 22G nozzle (400 micron distance between nozzle and printing surface). Pre-flow delay of
100 ms. UV crosslinking for 10 s at 405 nm wavelength, 4 cm separation. Two layers are included in this print structure
thickness. UV crosslinking occurred only once, at the end of the print, rather than between layers. Printing surface was
a 6 well plate. Speed at 8 mm/s for all print trials. 10 mm diameter with 1 mm thickness.

Printer overhead light reduced to 20%. GelMA cartridge placed in temperature controlled print head, set at 37˚ for 45
minutes. Temperature reduced to 25.8˚ and 15 minutes passed to allow for thorough cooling. 

Temperature 25.8˚. Pressure 28 kPa. 35% infill density. Structure printed, but there were inconsistencies in
extrusion and low infill density resulted in empty pockets in the structure. 

See attachments for photo 1

Temperature 25.8˚. Pressure 35 kPa. 35% infill density. The structure printed with fewer inconsistencies in
the extrusion. The increased GelMA flow due to the increased pressure resulted in better a better ratio
between extrusion speed and print head speed. 

See attachments for photo 2

see attachments for photo 3 (all 4 gels)

see attachments for photo 4 (Close-up of surface) Surface structure is much flatter than previous prints have
been. This is an advantage for future cell culture. 

Conclusions/action items: Perform stiffness testing on the printed gels tomorrow. 

Nick Herbst - Feb 28, 2024, 1:35 PM CST
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Title: Bioprinting Trial 6

Date: 03/3/2024

Content by: Caitríona

Present: Elijah, Nick, and Caitríona 

Goals: Fabricate bioprinted gels. 

Content:

**Print attempt using a 22G nozzle (400 micron distance between nozzle and printing surface). UV crosslinking for 13 s
at 405 nm wavelength, 4 cm separation. Cylinder structure dimensions: 10 mm diameter with 1 mm thickness. Two
layers are included in this print structure thickness. UV crosslinking occurred only once, at the end of the print, rather
than between layers. Printing surface was a 6 well plate. Speed at 8 mm/s for all print trials. 

Printer overhead light reduced to 20%. GelMA cartridge placed in temperature controlled print head, set at 37˚ for 45
minutes. Temperature reduced to 25.8˚ and 15 minutes passed to allow for thorough cooling. 

Temperature 25.8˚. Pressure 30 kPa. 35% infill density. Pre-flow of 100 ms. First two structures printed, but
with inconsistencies in the first part of the first layer. Pre-flow density will be increased during the next trial to
address this challenge. The nozzle clogged, and the third print did not extrude.

 
Temperature 25.8˚. Pressure 30 kPa. 35% infill density. Pre-flow of 200 ms. Unsuccessful.
Temperature 25.8˚. Pressure 30 kPa. 35% infill density. Pre-flow of 200 ms. Unclogged the nozzle and did
not change any print parameters because test flow functioned properly. Unsuccessful.
Temperature 26.1˚. Pressure 36 kPa. 35% infill density. Pre-flow of 200 ms. Extreme curling, nothing
extruded onto the surface. Unsuccessful.
Temperature 26.1˚. Pressure 35 kPa. 35% infill density. Pre-flow of 200 ms. Surface extrusion was
extremely blotchy and inconsistent. Unsuccessful.

Caitriona Treacy - Apr 30, 2024, 3:31 PM CDT
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Temperature 26.4˚. Pressure 35 kPa. 35% infill density. Pre-flow of 200 ms. Gel was globbling onto the
printer tip and had a liquid character to it. Print was unsuccessful. We are recalibrating and returning to
original temperature of 25.8˚ for the next print. Temperature changed, and 8 minutes passed. 
Temperature 25.8˚. Pressure 39 kPa. 35% infill density. Pre-flow of 200 ms. Same globbing problem, all
GelMA collected on the tip. Tip replaced for the next trial. 
Temperature 25.8˚. Pressure 52 kPa. 35% infill density. Pre-flow of 200 ms. First gel structure looked good.
The second two had large gaps and were largely incomplete. 
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Temperature 25.8˚. Pressure 54 kPa. 35% infill density. Pre-flow of 200 ms.

Temperature 25.8˚. Pressure 55 kPa. 35% infill density. Pre-flow of 200 ms. First two gels were extremely
blotchy, barely any extrusion. Unsuccessful.
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Temperature 25.8˚. Pressure 55 kPa. 35% infill density. Pre-flow of 200 ms. Nothing extruded.
Unsuccessful. 
Temperature 26.0˚. Pressure 60 kPa. 35% infill density. Pre-flow of 200 ms. Inconsistent structures for all
three gels. Filament kept fragmenting as the nozzle turned. Nozzle speed decreased for the next trial. 

Temperature 26.0˚. Pressure 58 kPa. 35% infill density. Pre-flow of 200 ms. Print head speed decreased to
7.0 mm/s. All three gels printed. Structure integrity deteriorated with each. Fragmenting of filament still
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seems to be the main concern, increased temperature to address this issue and waited 8 minutes before the
next print.  

Temperature 26.2˚. Pressure 50 kPa. 35% infill density. Pre-flow of 200 ms. Print head speed 7.0 mm/s.
Terrible structures, random fragments on the surface. The filament is not maintaining continuity throughout
the print. Temperature increased again, to 26.4˚, and 8 minutes passed before the next print. 
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Temperature 26.4˚. Pressure 50 kPa. 35% infill density. Pre-flow of 200 ms. Print head speed 7.0 mm/s.
Fragmented structures again. Stopped print after 2 gels. Temperature increased again, and 8 minutes
passed before the next print. 

Temperature 26.6˚. Pressure 60 kPa. 35% infill density. Pre-flow of 200 ms. Print head speed 7.0 mm/s.
Improvement in all three structures compared to last print, still with some fragmenting happening. Increased
the temperature again and allowed 8 minutes to pass before the next print. 
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Temperature 26.8˚. Pressure 60 kPa. 35% infill density. Pre-flow of 200 ms. Print head speed 7.0 mm/s. All
three gels printed with cylindrical structure. Small ridges suggest need for higher infill density. 

Temperature 26.8˚. Pressure 61 kPa. 40% infill density. Pre-flow of 200 ms. Print head speed 7.0 mm/s.
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These six willl be left for Dianhua to perform cell seeding on.

Conclusions/action items: Perform cell seeding on the final 6 gels that were printed and use today's fabrication
to update bioprinter protocols. 
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 03/04/2024 3T3 Encapsulated Gel Fabrication Protocol

Title: 3T3 Encapsulated Gel Fabrication Protocol 

Date: 03/03/24

Content by: Carley 

Present: Will and Carley 

Goals: Create cell encapsulated gels 

Content: 

GelMA  Media uL LAP uL Seeding Media uL Number of Cells (million) Number of Gels

25  425 25 50 10 (1,000,000 per gel) 4

25 425 25 50 5 (500,000 per gel) 4

25 425 25 50 2.5 (100,000 per gel) 4

 

cells/mL - 28.8 million cells 

Hydrogel Fabrication Protocols 

1. Set water bath to 50 ℃

2. Measure out 50 mg of GelMA and place in 5ml sterile tube

3. Add 850µL of embedding media and place in water bath [PBS if not using embedding media]

4. While GelMA is dissolving, prepare a 20 million cells/ml stock solution [Can vary based on cell type to be encapsulated] 

5. Sanitize molds with ethanol and UV light [Maximum 5 minutes, can deform the molds] 

6. Press silicone molds to a petri dish, making sure that the seal is tight to prevent polymer solution from leaking

7. Get dissolved GelMA solution from water bath

8. Moving quickly to prevent temperature dependent gelation of the GelMA solution, add 50 µL of LAP and 100 µL cell solution and mix well

9. Place 100 µL of solution into each 9mm silicone mold

10. Place gels in 4 ℃ fridge for 15 minutes [Can vary]

11. Place gels under UV light for 5 minutes

12. Place gels in 24 well plate with 400 µL of media

Conclusions/action items:

 

Nick Herbst - Mar 08, 2024, 3:31 PM CST
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 03/08/2024 Bioprinting Trials 7

Title: Bioprinting Trial 7

Date: 03/8/2024

Content by: Caitríona

Present: Elijah, Nick, Carley and Caitríona 

Goals: Fabricate bioprinted gels. 

Content:

**Print attempt using a 22G nozzle (400 micron distance between nozzle and printing surface). UV crosslinking for 13 s
at 405 nm wavelength, 4 cm separation. Cylinder structure dimensions: 10 mm diameter with 1 mm thickness (layer
thickness = 0.51 mm). Two layers are included in this print structure thickness. UV crosslinking occurred only once, at
the end of the print, rather than between layers. Printing surface was a 6 well plate. Speed at 7.0 mm/s for all print
trials. 

Printer overhead light reduced to 20%. GelMA cartridge placed in temperature controlled print head, set at 37˚ for 45
minutes. Temperature reduced to 26.1˚ and 25 minutes passed to allow for thorough cooling. 

Temperature 26.1˚. Pressure 40 kPa. 45% infill density. Pre-flow of 100 ms. The first structure printed, but
with inconsistencies in the first part of the first layer. The nozzle clogged, and the second/third print did not
extrude. 
Temperature 26.1˚. Pressure 40 kPa. 45% Infill density. Pre-flow of 100 ms. The first structure printed the
second half of the first layer and all the second layer. This specific gel appears to be a little crater shaped in
the middle, but is similar in size to the first gel. 
Before this print, we recalibrated the printhead so that the 22G nozzle was not protruding as much from the
insulating nozzle cover. The goal was to conceal more of the nozzle to block UV light. Temperature 26.1˚.
Pressure 46 kPa. 45% Infill density. Pre-flow of 100 ms. First two structures with variable structure. That is,
the final gels are filled in, but filament was breaking, leaving gaps over the duration of the print. The third gel
was extremely thin and variable. Upon inspection, the GelMA cartridge was emptied completely. This should
be noted as a factor that likely affected all three of these structures.

Conclusions/action items: Gels will be transported to ECB where they will be put into media and incubated for
24 hours prior to stiffness testing. 

Caitriona Treacy - Mar 08, 2024, 2:37 PM CST
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Title: Bioprinting Trial 8

Date: 04/05/2024

Content by: Elijah

Present: Elijah & Caitríona

Goals: Fabricate bioprinted gels. 

Content:

**Print attempt using a 22G nozzle (400 micron distance between nozzle and printing surface). UV crosslinking for 13 s
at 405 nm wavelength, 4 cm separation. Cylinder structure dimensions: 10 mm diameter with 1 mm thickness (layer
thickness = 0.51 mm). Two layers are included in this print structure thickness. UV crosslinking occurred only once, at
the end of the print, rather than between layers. Printing surface was a 6 well plate. Speed at 7.0 mm/s for all print
trials. 

Printer overhead light reduced to 20%. GelMA cartridge placed in temperature controlled print head, set at 37˚ for 40
minutes. Temperature reduced to 26.1˚ and 25 minutes passed to allow for thorough cooling. 

Temperature _26.1_˚. Pressure _25_ kPa. _45%_ infill density. Pre-flow of _-200_ ms. Speed of __7.0
mm/s___** Test flow was very liquidy, not a gel-like consistency. Switch to 25.8 degrees celcius to fix this
issue. 
Temperature __25.8__ Pressure _25_kPa.  _45%_ infill density. Pre-flow of _-200_ms. Speed of
__7.0mm/s_ ** First two structures have decent shape. Printer still fails to complete full circle leaving "tail" of
GelMA on the first layer. Third structure first layer was very bad but second layer filled in some of the gaps.
Will run one more trial with an increased pressure to try and fix problem. First two gels appear to be
testable.
In between these 2 trials, the printer refused to recalibrate. Restarted printer. 
Temperature __25.8__ Pressure _42_kPa.  _45%_ infill density. Pre-flow of _-200_ms. Speed of
__7.0mm/s_ ** Test flow looked ok. Not as liquidy as trial 2. Structures 1-3 on this print trial look similar to
gels that we have previously printed. Very thin and the infill doesn't appear to be making a complete
structure. 
Temperature __25.8__ Pressure _42_kPa.  _50%_ infill density. Pre-flow of _-200_ms. Speed of
__7.0mm/s_ ** Infill density increased to 50% to combat problem of gel not printing complete structure.
Allowed structure 1 to print and it did not look good. Cancelled print and went home due to worries of
wasting GelMA. Printing will resume soon. 

After thoughts: The trial 2 structures were much better than the other trial structures in terms of infill. I am thinking this is
due to the GelMA being at a more liquidy appearance as mentioned above. This allowed the infill to be greater than the
set value due to greater amounts of GelMA exiting the nozzle. Trouble shooting appears to becoming much easier for
the groups in terms of getting the printer to extrude. The structure however still seems to be causing us issues. I think
that this is an infill density problem and we need to structure our following prints on this idea. 

ELIJAH DIEDERICH (ediederich@wisc.edu) - Apr 30, 2024, 8:46 PM CDT
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Conclusions/action items: Gels will be transported to ECB where they will be put into media and incubated for
24 hours prior to stiffness testing. 

Team activities/Fabrication/04/05/2024 Bioprinting Trials 8 63 of 149



 Cell Encapsulated Gel Fabrication 04-08-24

Title: Encapsulated Gel Fabrication 

Date: 04-08-24

Content by: Carley

Present: Carley & Will 

Goals: To create fibroblast encapsulated hydrogels 

Content:

Gel Types 24 hr, 48 hr, 7 day, and 14 day 14 day controls Total Gels Cells per gel

Healthy  3 +1  3 +1  10 250,000 cells 

Fibrotic 3 +1 3 + 1 10 250,000 cells

We will make 10 gels in total for each condition 

Conclusions/action items:

Gels were made following previously described protocols. 

CARLEY SCHWARTZ - Apr 08, 2024, 5:10 PM CDT
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Title: Bioprinting Trials

Date: 4-10-2024

Content by: Elijah and Caitriona

Present: Elijah and Caitriona

Goals: To bioprint gels and continue to try and optimize their structures

Content:

**Print attempt using a 22G nozzle (400 micron distance between nozzle and printing surface). UV crosslinking for 6 s at 405 nm
wavelength, 4 cm separation. Cylinder structure dimensions: 10 mm diameter with 1 mm thickness (layer thickness = 0.51 mm).
Two layers are included in this print structure thickness. UV crosslinking occurred only once, at the end of the print, rather than
between layers. Printing surface was a 6 well plate. Speed at 7.0 mm/s for all print trials. 

Printer overhead light reduced to 20%. GelMA cartridge placed in temperature controlled print head, set at 37˚ for 45 minutes.
Temperature reduced to 26.1˚ and 25 minutes passed to allow for thorough cooling. 

Temperature 25.9˚ C Pressure _42_ kPa. 55% infill density. Pre-flow of -200 ms.  ** 3 structures printed, nozzle
dragged, but the gels had decent structure. Convinced that this may be due to the increased infill density, as the test
flow filament looked very good (gel-like, not liquidy). Next trial will have a decreased infill density

Caitriona Treacy - Apr 30, 2024, 7:03 PM CDT

Team activities/Fabrication/04/10/2024 Bioprinting Trials 66 of 149



Temperature 25.9˚ C Pressure _38_ kPa. 52% infill density. Pre-flow of -200 ms. ** First structure printed looked very
good, no gaps in circle structure (maybe best structure ever printed). Second and third gel of the trial did not look great.
Many gaps in structure (outer and inner rings). We think this may be due to a temperature issue where the GelMA is too
thick as the printing progresses. **
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Temperature 26.1˚ C Pressure _42_ kPa. 52% infill density. Pre-flow of -200 ms. **First structure looked pretty good,
had minimal gaps in the circular printing structure but worse than last trial. Second and third structure showed much
more gaps and are not testable at all. GelMA appears to be gathering near the middle circles and "piling up", getting
caught on previous circles printed. This causes gaps between the circular layers and untestable gels to print. Will do one
more trial by decreasing the print speed, hoping to fix this issue.

 

For this trial below, the print speed was decreased to 6.5 mm/s.

Temperature 26.1˚ C Pressure _42_ kPa. 52% infill density. Pre-flow of -200 ms. ** All three of these prints came out
VERY thin (<1mm), but the concentric pattern was strong overall. The first one had no visible gaps in the structure,
whereas there were some visible inconsistencies in the second and third, but the structure looked continuous overall in
all three prints. Might think about increasing the temperature next time to keep the filament from clumping and to
extrude more volume per print.
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Conclusions/action items:

1. Prepare for ImageJ analysis next week

2. Finish up LIVE/DEAD imaging
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Title: Bioprinting Trial Pre-Advisor Meeting

Date: 4-12-24

Content by: Elijah and Caitriona

Present: Elijah and Caitriona

Goals: To further work on optimization of structure and printing parameters

Content:

**Print attempt using a 22G nozzle (400 micron distance between nozzle and printing surface). UV crosslinking for _6_ seconds at
405 nm wavelength, 4 cm separation. Cylinder structure dimensions: 10 mm diameter with 1 mm thickness (layer thickness = 0.51
mm). Two layers are included in this print structure thickness. UV crosslinking occurred only once, at the end of the print, rather
than between layers. Printing surface was a 6 well plate. Speed at 6.5 mm/s for all print trials. 

Printer overhead light reduced to 20%. GelMA cartridge placed in temperature controlled print head, set at 37˚ for 45 minutes.
Temperature reduced to 26.1˚ and 25 minutes passed to allow for thorough cooling. 

Temperature 26.1˚ C Pressure  _32_ kPa. 52% infill density. Pre-flow of -200 ms.  ** GelMA looked a tad bit liquidy
on the testflow before the print, decreased the pressure to combat this issue. First structure was very large due to
temperature being too high. Print cancelled. Temperature reduced. 

Caitriona Treacy - Apr 30, 2024, 6:30 PM CDT
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Figure 1: Top view (left) and side view (right) of the first print trial. Lacking precise structure, it looks as though the printer
dispensed liquid GelMA rather than extruding filament.

Temperature _25.9__˚ C Pressure  __43_ kPa. 52% infill density. Pre-flow of -200 ms. ** Gels looked absolutely
fabulous if I say so myself. I think these may be the best gels we have ever printed. Structure looked very similar
throughout all three gels printed. Will try to replicate in next trial for an N=6 value for rheometry testing. 

Team activities/Fabrication/04/12/2024 Bioprinting Trials 72 of 149



Figure 2: Top view of print 2 of the day. All three gels printed with consistent structure. 

Temperature _25.9__˚ C Pressure  __43_ kPa. 52% infill density. Pre-flow of -200 ms. ** Very good trial print again,
these gels appeared to be little bit thinner than the previous trial even though all parameters were maintained. We will
try to print another trial with a small increase in temperature because the opening and closing of the bioprinting door
may be affecting the temperature of the GelMA. 

Figure 3: Top view of print 3 of the day. All three gels have consistent structure in the middle, but start to lack volume on the outer
edges. There appears to be gapping occurring between concentric filaments. 

Side view of trial 2 (left) and trial 3 (right) in an effort to show the gel thickness:
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Figure 4: A side view of print 2 (left) and print 3 (right). As can be seen in the image, the gels from print 2 had a higher average
thickness than those from print 3, despite the print settings being the same.

Temperature _26.0__˚ C Pressure  __42_ kPa. 52% infill density. Pre-flow of -200 ms. ** Gels did not print very well.
Their structures have significant gaps for all three gels in between the circular printed rings. Temperature was increased
again back to 26.1 to see if this makes a difference in structural integrity. 

Figure 5: Top view of the gels from print 4 of the day. The structural integrity of these gels continues to decline with each print.
These three gels have too much gapping between filaments to be able to run mechanical testing on them.

Temperature _26.2__˚ C Pressure  __44_ kPa. 52% infill density. Pre-flow of -200 ms. ** Did a test-flow at 26.1
degrees C and the GelMA looked thick. Increased to 26.2 degrees C. Not due to lack of effort, the 3 structures printed

Team activities/Fabrication/04/12/2024 Bioprinting Trials 74 of 149



were very subpar. GelMA failed to dispense from the nozzle at times, leaving holes in the circular printed structure.
Upon removal of the cartridge, it was noted that very little GelMA was left in the cartridge. This likely had an influence
on the final print trial and could be why so little material was dispensed. This last print resulted in one tube of GelMA
being used up out of the previous 3 ordered. 2 left in the refrigerator. 

Figure 6: Top view of gels from print 5 (top row) and print 4 (bottom row). Extreme lack of volume, likely caused by low GelMA
supply in the cartridge, as described above.

 

** All gels printed today brought to client meeting to show advisor the inconsistencies that this printer along with the
difficult reproducibility of this material **

 

Conclusions/action items:

1. Advisor Meeting at 12:05, bring these new gels with to discuss latest prototypes. 

2. Need to start developing multiple protocols that will lead to the greatest success
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Title: Bioprinting Trials - 4/17/24

Date: 4/17/2024

Content by: Elijah and Caitriona 

Present: Elijah and Caitriona

Goals: To continue to optimize bioprinter settings for the final report

Content:

**Print attempt using a 22G nozzle (400 micron distance between nozzle and printing surface). UV crosslinking for _4_ seconds at
405 nm wavelength, 4 cm separation. Cylinder structure dimensions: 10 mm diameter with 1 mm thickness (layer thickness = 0.51
mm). Two layers are included in this print structure thickness. UV crosslinking occurred only once, at the end of the print, rather
than between layers. Printing surface was a 6 well plate. Speed at 6.5 mm/s for all print trials. 

Printer overhead light reduced to 20%. GelMA cartridge placed in temperature controlled print head, set at 37˚ for 45 minutes.
Temperature reduced to 26.3˚ and 25 minutes passed to allow for thorough cooling. 

Temperature _25.7˚_ C Pressure  __36_ kPa. _52%__ infill density. Pre-flow of -200 ms.  **Test-flow was very
liquidy, so the temperature was backed down to 26.1 degrees C and left to cool for 5 minutes. Test Flow #2 - Test flow
#2 was also very liquidy. Temperature was bumped down again to 25.9 degrees C and left to cool for 5 minutes. Test
flow #3 - still looked very liquidy. Temperature bumped down again to 25.7 degrees C and left to cool for 5 minutes.
After adjusting the pressure, the test flow appeared to be more gel-like and the print commenced. All 3 gels printed had
pretty decent structure and will all be able to be rheologically examined. 

Caitriona Treacy - Apr 30, 2024, 6:50 PM CDT
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Figure 1: Top view of print 1. The outer ring of structure on the last two prints shows inconsistencies. 

Temperature _25.7˚_ C Pressure  __36_ kPa. _52%__ infill density. Pre-flow of -200 ms. ** Test-flow with the same
settings at trial 1 was very similar. The print was then started. Similar to what has been happening in the previous
bioprinting sessions, the gels were visibly thinner than the first trials despite having the same settings. The first gel
printed had a complete structure but was thinner. The 2nd and 3rd gel of this print lacked structure, including gaps in
the circular printed rings. The first and second gels will be saved for rheology testing, while the third was discarded. 

Figure 2: Top view of print 2. Structural degradation with each consecutive print. 

Temperature _26.0˚_ C Pressure  __38_ kPa. _52%__ infill density. Pre-flow of -200 ms. Temperature of this print was
increased to 26.0 because of the lack of structure in the previous trial. Test-flow looked like a gel-filament and the print
was started. Gels are still noticeably thinner compared to trial #1. Preliminary results from previous rheology testing
shows that this will have an impact on the Young's Modulus. 3 very thin structures were printed and transferred to ECB
for swelling. Rheology testing will be performed 24 hours post-printing to obtain Young's Modulus. 
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Figure 3: Top view of print 3. The concentric pattern structure looks good, but the thickness of these gels suggests that insufficient
volume was being dispensed during this print (see figure 4). 

Side view of print 3:

Figure 4: Side view of print 3 in an effort to show how thin this print trial was. Despite the structure thickness being set to 1 mm,
these gels had a thickness of about 0.75 mm. 

Conclusions/action items:
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1. Perform Rheology on printed gels

2. Begin to work on poster for 4/26
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Title: Pre-Advisor Meeting Bioprinting

Date: 4-19-24

Content by: Elijah and Caitriona

Present: Elijah and Caitriona

Goals: To print gels in the healthy lung tissue range for poster

Content:

**Print attempt using a 22G nozzle (400 micron distance between nozzle and printing surface). UV crosslinking for _2 (Not for
trial 1; see below)_ seconds at 405 nm wavelength, 4 cm separation. Cylinder structure dimensions: 10 mm diameter with 1 mm
thickness (layer thickness = 0.51 mm). Two layers are included in this print structure thickness. UV crosslinking occurred only
once, at the end of the print, rather than between layers. Printing surface was a 6 well plate. Speed at 6.5 mm/s for all print trials. 

Printer overhead light reduced to 20%. GelMA cartridge placed in temperature controlled print head, set at 37˚ for 45 minutes.
Temperature reduced to 26.3˚ and 25 minutes passed to allow for thorough cooling. 

Temperature _25.9˚_ C Pressure _35_ kPa. _52%__ infill density. Pre-flow of -200 ms. ** Test flow looked good at
25.9˚ C compared to 26.1˚ C. Three gel structures were able to get printed but were pretty large. This may be due to a
temperature issue, so we will compensate for this during the next trial. The UV time also appeared to be __6__ seconds
for this trial, even though the UV time was set to _2_ seconds. This was reflected as being 6 seconds and the print was
exited to hopefully solve this issue. 

Figure 1: Top view of print 1. All three gels printed with structures lacking gaps, but diameters exceed 10 mm. 

Temperature _26.0˚_ C Pressure  _46_ kPa. _52%__ infill density. Pre-flow of -200 ms. ** Test flow looked great, first
2 gels printed looked great, but the last one appeared to be getting thicker. Temperature increased by 0.1 degrees C for
next trial. This UV time appeared to be 2 seconds. We will do one more trial so that we have more data for this UV
time. 

Caitriona Treacy - Apr 30, 2024, 7:00 PM CDT
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Figure 2: Top view of print 2. Loss of structural integrity on the third gel off this print, observed to likely be due to an increase of
viscosity in the GelMA as the print progressed. 

Temperature _26.3˚_ C Pressure _45_ kPa. _52%__ infill density. Pre-flow of -200 ms. ** After a bit of tinkering with
the pressure and temperature, the test-flow looked good (gel-like filament) and the print was started. First gel printed
looked good, all the circular printed motions looked filled in with no gaps. The second and third gel were a bit worse,
having some gaps in the circular printed layers. 

 

Figure 3: Top view of print 3. Gaps between GelMA filaments started to become apparent in gels 2 and 3 of this trial.  

Conclusions/action items:

1. Work on poster presentation

2. Gather rheometry results for 2 seconds UV
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 03/12/2024 Cell Encapsulation for LIVE/DEAD troubleshoot

Title: Cell Encapsulation for LIVE/DEAD troubleshoot

Date: March 12th, 2024

Content by: William

Present: William 

Goals: To fabricate gels to troubleshoot LIVE/DEAD staining's washout problem

Content:

Cells 

Conclusions/action items:

Use gels to troubleshoot LIVE/DEAD Staining protocol as described in "Design of Troubleshooted LIVE/DEAD Staining Protocol"

 

WILLIAM ONUSCHECK - May 01, 2024, 11:01 AM CDT
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 02/09/2024 Preliminary LIVE/DEAD Staining Protocol

Title: Preliminary LIVE/DEAD Staining Protocol

Date: 02/09/2024

Content by: Nick Herbst

Present: Nick Herbst

Goals: Establish protocol for LIVE/DEAD staining

Content:

Materials:
1. LIVE/DEAD Viability Kit (Thermofisher) containing calcein AM and ethidium
homodimer-1
2. 15mL conical tube
3. 20μL pipette + tips
4. 1000μL pipette + tips
5. 10mL serological pipette
6. Phosphate-buffered saline (PBS)
7. Fluorescence microscope
Method:
1. Use the serological pipette to add 10mL of PBS to the conical tube
2. Add 5μL calcein AM and 20μL ethidium homodimer-1 to the PBS
a. Homogenize the staining solution by inverting the tube gently several times
3. Remove media from cells and wash twice with PBS
4. Add 200μL of staining solution directly to cells
5. Cover with aluminum foil and let it incubate for 30 minutes at room temperature
6. Image the cells under a fluorescence microscope
a. Use the FITC filter for calcein-AM (live cells)
b. Use the RFP filter for ethidium homodimer-1 (dead cells)

Conclusions/action items:

Use this protocol to image the fibroblasts encapsulated in GelMA hydrogels. Cell viability can be determined by comparing the number of calcein AM
positive cells to the number of ethidium homodimer-1 positive cells

Nick Herbst - Mar 08, 2024, 3:28 PM CST
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Title: Rheology Protocol

Date: 02/27/2024

Content by: Elijah Diederich

Present: Myself

Goals: To inform fellow notebook readers about the rheology protocol used 

Content:

 

Frequency Sweep Rheometry Protocol

1. Once GelMA hydrogels have been formed and allowed to set and swell for approximately 24 hours, rheometry
testing may be performed.

2. Carefully remove 3-4 hydrogels of each type; healthy lung ECM and fibrotic lung ECM, keeping the gels of the
same type in their respective petri dish. 

3. Once gels are in two separate weighing dishes, make your way over to the rheometer testing machine (Malvern
Rheometer - Kinexus Ultra+)

4. Make sure that the bottom plate is locked on the rheometer by pushing the level, located on the front of the
machine below the bottom parallel plate, all the way to the right

5. Open rSpace application on the computer and when prompted to select a certain test, select the 0035 test;
Frequency Sweep Strain controlled. 

6. When this specific test is selected, the user will then be prompted to enter a Gap value. This value will
pertain to the thickness (mm) of the hydrogel being tested. Center the hydrogel on the bottom parallel plate.
Measure the thickness (mm) of the hydrogel and enter the gap value. The upper plate will then move to this
gap value.

7. Once making sure that the upper plate makes contact with the top of the hydrogel and the thickness is the
correct value, enter values for various testing parameters such as room temperature, start frequency, end
frequency, shear strain %, and samples per decade. In this specific test, the values were as follows: Start
Frequency = 0.1 Hz, End Frequency = 10 Hz, Room Temperature = 25 ℃, shear strain = 1%, and 10 samples per
decade. 

8.  Once the various testing parameters are entered, the user will then be able to start the test. A 5 minute
calibration will be performed before the actual test begins. Once this calibration has been completed, the
frequency sweep test will take approximately 10 minutes. 

9. When the test is completed, the results table can be copied into an excel spreadsheet. Enter a gap value that
is greater than the thickness of the hydrogel to remove the hydrogel from the machine. Clean upper and lower
parallel plate surfaces with ethanol. 

10. Repeat steps 5-9 for remaining hydrogels. In this specific test, 3-4 hydrogels of each type were tested for a
total of 6-8 separate frequency sweeps. 

11. When testing is completed, results can be interpreted in Excel. 

 

Conclusions/action items:

1. Proofread prelim report sections

 

Nick Herbst - Feb 27, 2024, 10:42 AM CST
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Title: Improved LIVE/DEAD Staining Protocol

Date: 03/12/2024

Content by: Nick Herbst

Present: Nick Herbst

Goals: Rewrite protocol for LIVE/DEAD staining with more in-depth information

Content:

Materials: 

15mL conical tube
20μL pipette + tips
1000μL pipette + tips
10mL serological pipette
Phosphate-buffered saline (PBS)
Fluorescence microscope
LIVE/DEAD Viability Kit (Thermofisher) containing calcein AM and ethidium homodimer-1 (EthD-1)

Store in a -20 ºC freezer protected from light
Either keep the reagent vials in a box or wrap them in foil

Before using the stock solutions, allow them to thaw to RT and centrifuge them briefly before opening them
Fluorophores can aggregate overtime

Calcein AM hydrolyzes when exposed to moisture, so be sure to keep it away from water (stock solution is in anhydrous
DMSO)
Aqueous working solutions of calcein AM should be prepared immediately prior to use and must be used within one day
Ethidium homodimer-1 is not sensitive to moisture; Aqueous working solutions of it can be stored at -20 ºC for up to one
year
Before refreezing stock solutions, seal all vials tightly

Fluorescent Dye Concentration Optimization:

1. Prepare samples of live and dead cells

1. Dead cells can be obtained by killing cells with 70% methanol for 30min
2. Use samples of dead cells to optimize the EthD-1 concentration

1. Dilute the EthD-1 in PBS to varying concentrations, add the dilutions to dead cells, incubate for 30min, then image

1. Try diluting EthD-1 to 0.1 - 10μM
2. You want the lowest EthD-1 concentration which stains the dead cell nuclei bright red with minimal cytoplasmic staining

3. Use a sample of dead cells to start to optimize the calcein AM concentration

1. Dilute the calcein AM in PBS to varying concentrations, add the dilutions to dead cells, incubate for 30min, then image

1. Try diluting calcein AM to 0.1 - 10μM
2. You want the lowest calcein AM concentration which gives minimal cytoplasm staining

4. Use a sample of live cells to confirm the optimization of the calcein AM concentration

1. Dilute the calcein AM in PBS to the same concentration that used in the prior step, add it to live cells, incubate for 30min,
then image

2. See if the used concentration gives a sufficient green stain in live cells

1. If not, try a higher concentration on another sample of live cells

LIVE/DEAD Staining:

1. Use the serological pipette to add 10mL of PBS to the conical tube
2. Add enough calcein AM and ethidium homodimer-1 to the PBS to achieve the concentrations determined in optimization process

1. Anecdotally, 20μL of EthD-1 and 5μL of calcein AM in 10mL of PBS gives concentrations of 4μM and 2μM, respectively,
and is suitable for 3T3 cells

2. Homogenize the staining solution by inverting the tube gently several times
3. Remove media from cell-laden hydrogels and wash with PBS

1. Do 3-5 5min washes

Nick Herbst - Mar 12, 2024, 2:16 PM CDT
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4. Add 200μL of staining solution directly to the hydrogels
5. Cover with aluminum foil and let it incubate for 30 minutes at room temperature
6. Image the cells under a fluorescence microscope

1. Dim the lights in the working space and keep the gels covered whenever not imaging
2. Use the FITC/GFP filter for calcein-AM (live cells)
3. Use the TRITC/RFP filter for ethidium homodimer-1 (dead cells)

Tips:

If you have extracellular fluorescence, do additional and/or longer washes with PBS prior to staining because media can have
esterases which hydrolyze the calcein AM to cause fluorescence

Calcein AM is calcein acetoxymethyl ester, and it functions by permeating live cell plasma membranes and then getting
hydrolyzed by intracellular esterases which releases the fluorescent calcein

Be sure to dim the lights of the work space and have cells covered in foil when not actively adding something or imaging
The fluorescent dyes are photosensitive

Conclusions/action items:

Use this protocol to image the fibroblasts encapsulated in GelMA hydrogels. Use the Cell Viability Image Analysis protocol to analyze the captured
fluorescent images
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Title: Cell Viability Image Analysis Protocol

Date: 03/20/2024

Content by: Nick Herbst

Present: Nick Herbst

Goals: Write step-by-step protocol for using ImageJ to analyze the LIVE/DEAD staining images to quantify cell viability

Content:

Materials: 

Computer
ImageJ software with Bio-Formats plugin package
Fluorescent LIVE/DEAD staining images

Methods:

1. Capture a fluorescent image and save the file with both the green (live) and the red (dead) channels

1. If a Nikon fluorescence microscope was used, the file will save as a .nd2 \
2. Open the file in ImageJ

1. File > Open > select the .nd2 file
2. In the Bio-Formats Import Options window, set “View stack with:” to “Hyperstack” and “Color mode:” to “Default”
3. Click “OK”

3. Split the image such that each channel is its own image

1. Image > Color > Split Channels
2. Close the blue channel since only the green and red channels will be used

4. Change the images’ type

1. Image > Type > 8-bit
5. Eliminate some background noise by adjusting the brightness and contrast

1. Image > Adjust > Brightness/Contrast
2. A window will pop up with a pixel intensity histogram

1. Move the “Minimum” slider to the right until the image looks cleaner without losing any important signal
2. If necessary, move the “Maximum” slider to the left to increase the intensity of the staining
3. When done, click “Apply”

3. Repeat B/C adjustment for the other image
4. Keep B/C settings constant between different images of the same channel

1. All green images should have same settings and all red images should have same settings, but green and
red images don't have to have the same settings

6. Convert the gray-scaled images into binary images via Thresholding

1. Image > Adjust > Threshold

1. Make sure dropdown menus say “Default” and “Red” and that “Dark background” is checked
2. Move the top slider (the left bound of the the threshold) so that only the stained cells are highlighted in red
3. Thresholding is a critical step

1. Too high of a threshold results in losing a lot of signal
2. Too low of a threshold will fuse cells close to each other and include background noise, making counting

more difficult
4. Click “Apply” to get a binary thresholded image
5. Repeat thresholding for the other image

7. On both images, separate fused cells

1. Process > Binary > Watershed
8. Set up the measurements window

1. Analyze > Set Measurements
2. Make sure “Area” is checked

Nick Herbst - Apr 09, 2024, 11:37 AM CDT
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3. Click “OK”
9. Establish inclusion criteria for analysis

1. Analyze > Analyze Particles
2. Check “Add to Manager” and “Include holes”
3. Set “Size” to “0-Infinity” and “Circularity” to “0.00-1.00”
4. Click “OK”
5. With the ROI Manager open, click on a ROI that is the smallest but is still clearly a stained cell, then click “Measure” in the

window to get its area in μm2

6. Record this area, then click “Delete” to delete all ROIs from the manager
7. Repeat this process for the other image

1. Dead cells are smaller than live cells, so you cannot use the same minimum area for both images
10. Obtain stained cell counts for each image

1. Once again, go to Analyze > Analyze Particles
2. Check “Summarize” and “Include holes”
3. Set “Circularity” to “0.00-1.00”
4. Set “Size” such that the minimum is slightly smaller than the area that was recorded from the previous step and the

maximum is “Infinity”
5. Click “OK”
6. In the Summary window that pops up, record the value in the “Count” column

1. This is the number of stained cells for that particular channel
7. Repeat this process for the other image

11. Calculate the percentage of live cells to obtain cell viability

1. % Live = (Countgreen / (Countgreen + Countred)) * 100

1. Countgreen = number of live cells stained with calcein AM in the green channel

2. Countred = number of dead cells stained with ethidium homodimer-1 in the red channel

Conclusions/action items:

Use this protocol to analyze the captured fluorescent images
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Title: Final Bioprinting Protocol

Date: 04/30/24

Content by: Elijah & Caitríona 

Goals: Develop a comprehensive protocol for the bioprinter that is clear and can be easily followed by the client and others who
wish to replicate the design. 

Content:

Bioprinting Protocol without Cells:

1. Turn on the bioprinter and reduce lighting to 20% using the printer control options in the upper right corner of the home screen. 
Click on “Select Protocol” and then select “cait10mmx1mm”. Editing the protocol will allow the user to change settings for 
subsequent steps. This protocol currently has the following settings:

Dimensions: Cylindrical structure with 10 mm diameter and 2 mm thickness (2 layers)
Infill density: 52%
Printer head speed: 6.5 mm/s
Pre-flow delay: -200 ms
UV crosslinking once at the end (rather than between layers)
Print surface: 6-well plate. 
UV crosslinking wavelength: 405 nm
UV crosslinking distance: 4 cm

These print settings can be easily changed and saved in the protocol using the “edit protocol” tools before beginning the print. 

2. Remove GelMA cartridge from 4℃ fridge. Attach a 22G nozzle and the upper pressure hose to the cartridge and place it in the 
temperature-controlled print head. Place the desired printing surface into the lower print bed. Most likely this will be a 6- or 12-
well plate.  Set the temperature to 37˚C and let the GelMA heat up for 45 minutes. 

3. Once the GelMA has heated up for 45 minutes, reduce the temperature to 26.1˚C (printing temperature) and allow it to cool for 
30 minutes. 

4. Calibrate the printer. This can be done using the “move” option on the right side of the print screen. The metal calibration probe 
must be put in the vertical position for bed-leveling, and the printer door must be left open. Within the calibration menu, click 
“Automatic bed leveling” and follow the instructions on the screen. Once this is done, push the metal probe back into its neutral 
position and continue to “manual calibration” in the calibration menu. You will be prompted to move the print nozzle to the front 
left well of the print surface. To properly calibrate the height:

Ensure that the screw of the print head that secures the cartridge is completely loose. 
Adjust the height of the print head using the calibration controls until the nozzle makes contact with the print 
surface. Increase the height of the print head until the nozzle is mostly covered by the temperature-controlled print 
head. Leave ~1 mm of the nozzle exposed to avoid GelMA residue buildup in the metal nozzle cover. Open the 
printer door and tighten the screw to secure the position of the cartridge in the print head. 
With a 22G nozzle, the printer bed height should now be set 400 microns below the nozzle. If using a 27G nozzle, 
this distance should be 250 microns. Finalize the calibration. 

Note: After calibration, it can be useful to hit “print” followed promptly by “cancel print”. This will leave the print head in an elevated 
position, which makes unclogging and test flow more convenient before beginning the first print.  

5. A test flow will now be performed to determine if the GelMA is ready to print. Navigate to the pressure screen and hold a 
KimWipe underneath the print head nozzle. 

Starting at 35 kPa, perform a test flow. The test flow button must be held continuously throughout the test flow 
period. The filament coming out of the nozzle should appear gel-like without a viscous appearance. 
If the test flow has a low viscosity and appears to be liquid, the print temperature is too high. Reduce the print 
temperature by 0.1-0.2˚C and wait for 10 minutes. If multiple test flows at higher pressures are unsuccessful, the 
GelMA may be too viscous and the temperature should be increased by 0.1-0.2˚C and 10 minutes should pass 

Caitriona Treacy - Apr 30, 2024, 1:27 PM CDT
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before doing another test flow. Unclogging the nozzle between test flows and before beginning the print is 
crucial. 
If the filament curls around the tip of the nozzle to one side, the pressure is too low. Increase pressure in 
increments of 2 kPa. Continue to test flow until the filament does not curl around the nozzle. If the GelMA 
coming out of the nozzle expands around the tip in all directions upon leaving the nozzle, the pressure is too high 
and should be reduced. On average, successful prints happened within the range of 35-46 kPa.
Once the filament is gel-like and not curling around the nozzle, the user is ready to begin the print. Be sure to 
unclog before checking to make sure the UV light time is set to either fibrotic (13s) or normal (2s) range. Return 
to the printing screen. 
Note: Sometimes adjusting the UV crosslinking time in the print does not actually change how long the crosslinking occurs for. 
If this seems to be happening, exit the print and re-enter the protocol menu from the beginning. Click “edit protocol” and adjust 
the UV settings there before re-entering the print window. 

6. Click on the “Print” button on the printing screen to begin the print. 
7. The gels will print in the back 3 wells of the 6 well plate, and each gel will be subsequently crosslinked after being printed. 
8. Once the print is done (3 gels), rotate the 6 well plate 180˚ about the z-axis so that the other wells can be printed in during the 

next printing trial.
9. Repeat step 5 to make sure the gel is still in the optimal printing range. Temperature and pressure must continuously be 

monitored throughout the fabrication process. 
10. Click the “Print” button again to run another printing trial.
11. Place gels in hSAEC growth media for 24 hours to swell. 

Conclusions/action items: Send this final protocol to the client so that it can be used to fabricate gels in his lab.
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 MATLAB CODE for T-tests

Title: MATLAB CODE for T-tests

Date: April 29th 

Content by: William Onuscheck

Present: William Onuscheck

Goals: Compare cell viability between stiff and healthy groups for each day LIVE/DEAD imaging was performed 

Content:

importdata("ForTTest.xlsx")

% Sample data for two experimental groups and four timepoints

Healthy24 = (table2array(ForTTest(1:3,2)))'

Healthy72 = (table2array(ForTTest(4:8,2)))'

Healthy168 = (table2array(ForTTest(9:13,2)))'

Healthy336 = (table2array(ForTTest(14:18,2)))'

Fibr24 = (table2array(ForTTest(19:21,2)))'

Fibr72 = (table2array(ForTTest(22:26,2)))'

Fibr168 = (table2array(ForTTest(27:31,2)))'

Fibr336 = (table2array(ForTTest(32:35,2)))'

[h24,p24] = ttest2(Healthy24, Fibr24)

[h72,p72] = ttest2(Healthy72, Fibr72)

[h168,p168] = ttest2(Healthy168, Fibr168)

[h336,p336] = ttest2(Healthy336, Fibr336)

Conclusions/action items: Add to report. 
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 Rheometry 2-2-24

Title: Rheometry testing of bioprinted hydrogels

Date: 2-2-24

Content by: Elijah 

Present: Will and Anuraag

Goals: To determine preliminary stiffness of bioprinted hydrogels 

Content:

- Rheometry protocol followed can be found in the protocols portion of lab archives. 

Conclusions/action items:

1. Continue to bioprint gels

2. Schedule meeting with field scientist

ANURAAG SHREEKANTH BELAVADI - Feb 28, 2024, 2:34 PM CST
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 Rheometry 2-5-24/2-6-24

Title: Rheometry testing - Pipette hydrogels

Date: 1-30-2024

Content by: Elijah Diederich

Present: Will

Goals: To determine gel stiffness for pipette based hydrogels

Content:

 

- The protocol used can be seen in the rheometry protocol section of lab archives, further investigation of stiffness values will be included in further entries

Conclusions/action items:

1. Continue to make pipette based hydrogels and finish protocol

2. Work on bioprinter optimization protocol

 

ELIJAH DIEDERICH (ediederich@wisc.edu) - Feb 27, 202
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 Rheometry 2-8-24

Title: Rheometry testing 2-8-24

Date: 2-8-24

Content by: Elijah 

Present: Anuraag and Elijah 

Goals: To determine gel stiffness of bioprinted hydrogels

Content:

** Very variable gel sizes and printing parameters ** The team will look into optimizing these parameters as they continue their bioprinting journey

 

Conclusions/action items:

1. Figure out how to make similar structure gels and sizes

2. Meet with field scientist

 

ELIJAH DIEDERICH (ediederich@wisc.edu) - Feb 27, 2024, 3:52 PM CST
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 Rheometry 2-22-24

Title: Rheometry 2-22-24

Date: 2-22-24

Content by: Elijah Diederich

Present: Anuraag and Elijah 

Goals: To determine stiffness of bioprinted hydrogels

Content:

Conclusions/action items:

1. Continue to bio-print hydrogels with notes from field scientist

ELIJAH DIEDERICH (ediederich@wisc.edu) - Feb 27, 2024, 3:55 PM CST

Loading [MathJax]/extensions/Safe.js

Team activities/Testing and Results/Experimentation/Rheometry 2-22-24 101 of 149

https://www.labarchives.com/


 04/08/24 to 04/22/24 Cell Encapsulation & LIVE/DEAD testing

Loading [MathJax]/extensions/Safe.js

Team activities/Testing and Results/Experimentation/04/08/24 to 04/22/24 Cell Encapsulation & LIVE/DEAD testing 102 of 149

https://www.labarchives.com/


Title: Fibroblast gel encapsulated LIVE/DEAD staining

Date: 04-09-24

Content by: Carley

Present: Will and Carley

Goals: To assess live/dead fibroblasts at the 24 hour mark 

Content:

Following the protocol detailed below, we did the 24 hour staining on 3 of the gels, these gels will be saved and repeated at the other time points. At
each new timepoint two new gels will also be stained as a means to gauge if the repeated staining or time with stain effects cell growth. Table below
details what has been described

Time
Point 

Gels to be
stained

Gel notes

24

hours
3 gels

Bright field images of fibroblasts in healthy gels appeared
fibroblastic throughout the gel

Bright field images of fibroblasts in fibrotic gels appeared slightly
longer an average but still fibroblastic morphology

Still experiencing some issues where due to the gel being 3D
there is always some background fluorescence  

72

hours 

OG 3 gels

+ 2 new

Bright field images of both healthy and fibrotic gels had cells with
fibroblastic appearance

There seems to be some cracking in the gel structure that show
up in the bright field images. 

1 week
OG 3 gels
+ 2 new

Bright field images looked good once again

Seemed like cell viability was getting lower

Hydrogels are very fragile at this point in the culture

2

weeks 

OG 3 gels

+ 2 new

When doing the staining in the fibrotic is appeared that there was

a bit higher cell death compared to healthy and this was later
confirmed with ImageJ analysis. 

Materials:

15mL conical tube

20μL pipette + tips

1000μL pipette + tips

10mL serological pipette

Phosphate-buffered saline (PBS)

Fluorescence microscope

LIVE/DEAD Viability Kit (Thermofisher) containing calcein AM and ethidium homodimer-1 (EthD-1)

Store in a -20 ºC freezer protected from light 

Either keep the reagent vials in a box or wrap them in foil 

Before using the stock solutions, allow them to thaw to RT and centrifuge them briefly before opening them 

CARLEY SCHWARTZ - Apr 24, 2024, 1:44 PM CDT
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Fluorophores can aggregate overtime 

Calcein AM hydrolyzes when exposed to moisture, so be sure to keep it away from water (stock solution is in anhydrous DMSO) 

Aqueous working solutions of calcein AM should be prepared immediately prior to use and must be used within one day 

Ethidium homodimer-1 is not sensitive to moisture; Aqueous working solutions of it can be stored at -20 ºC for up to one year 

Before refreezing stock solutions, seal all vials tightly

Fluorescent Dye Concentration Optimization:

1. Prepare samples of live and dead cells 

1. Dead cells can be obtained by killing cells with 70% methanol for 30min 

2. Use samples of dead cells to optimize the EthD-1 concentration 

1. Dilute the EthD-1 in PBS to varying concentrations, add the dilutions to dead cells, incubate for 30min, then image

1. Try diluting EthD-1 to 0.1 - 10μM 

2. You want the lowest EthD-1 concentration which stains the dead cell nuclei bright red with minimal cytoplasmic staining 

3. Use a sample of dead cells to start to optimize the calcein AM concentration

1.  Dilute the calcein AM in PBS to varying concentrations, add the dilutions to dead cells, incubate for 30min, then image 

1. Try diluting calcein AM to 0.1 - 10μM 

2. You want the lowest calcein AM concentration which gives minimal cytoplasm staining

4. Use a sample of live cells to confirm the optimization of the calcein AM concentration 

1. Dilute the calcein AM in PBS to the same concentration that used in the prior step, add it to live cells, incubate for 30min, then image

2. See if the used concentration gives a sufficient green stain in live cells 

1. If not, try a higher concentration on another sample of live cells

LIVE/DEAD Staining:

1. Use the serological pipette to add 10mL of PBS to the conical tube

2. Add enough calcein AM and ethidium homodimer-1 to the PBS to achieve the concentrations determined in optimization process

1. Anecdotally, 20μL of EthD-1 and 5μL of calcein AM in 10mL of PBS gives concentrations of 4μM and 2μM, respectively, and is
suitable for 3T3 cells

2. Homogenize the staining solution by inverting the tube gently several times

3. Remove media from cell-laden hydrogels and wash with PBS

1. Do 3-5 5min washes

4. Add 200μL of staining solution directly to the hydrogels

5. Cover with aluminum foil and let it incubate for 30 minutes at room temperature

6. Image the cells under a fluorescence microscope

1. Dim the lights in the working space and keep the gels covered whenever not imaging

2. Use the FITC/GFP filter for calcein-AM (live cells)

3. Use the TRITC/RFP filter for ethidium homodimer-1 (dead cells)

Tips:

If you have extracellular fluorescence, do additional and/or longer washes with PBS prior to staining because media can have esterases which
hydrolyze the calcein AM to cause fluorescence
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Calcein AM is calcein acetoxymethyl ester, and it functions by permeating live cell plasma membranes and then getting hydrolyzed
by intracellular esterases which releases the fluorescent calcein

Be sure to dim the lights of the work space and have cells covered in foil when not actively adding something or imaging

The fluorescent dyes are photosensitive

Conclusions/action items:

Overall the staining protocol derived here works well and following updates will be made as staining progresses, note relevant to each timepoint and
the respective gels is noted in the table above. 
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 Rheometry 4-04 and 4-11

Title: Rheometry data for two bioprinting sessions

Date: 04-04 and 04-11

Content by: Carley

Present: Anuraag 

Goals: To test both rounds of bioprinted gels 

Content:

Conclusions/action items:

The thirteen second gel trial had an average of 18.5 which is perfect for our fibrotic but the 6 second was above the healthy range.

ANURAAG SHREEKANTH BELAVADI - Apr 24, 2024, 4:05 PM CDT
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 Rheometry 04/19

Title: Rheometry Testing 

Date: 04-09-24

Content by: Carley

Present: Anuraag 

Goals: To test bioprinted hydrogel stiffness

Content:

 

Conclusions/action items:

 

Both gel trials at 3 and 6 seconds showed good values but the variability in thickness does seem to be influencing the youngs modulus. 

ANURAAG SHREEKANTH BELAVADI - Apr 24, 2024, 4:05 PM CDT
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 Rheometry 04-18

Title: Rheometry data for bioprinted gels 

Date: 04-18

Content by: Carley 

Present: Anuraag

Goals: To test bioprinted gels

Content:

Conclusions/action items:

3 second UV time this round seemed to be at a higher average than previously at 6 kPa for the average but there were two gels of higher thickness
that had much higher youngs moduli that might be pulling as outliers in the average. 

ANURAAG SHREEKANTH BELAVADI - Apr 24, 2024, 4:05 PM CDT
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 04/22/2024 Cell Viability Data Analysis

Title: Cell Viability Data Analysis

Date: 04/22/2024

Content by: Nick

Present: Nick

Goals: Analyze the data from Will's LIVE/DEAD staining images using ImageJ and the previously described protocol

Content:

See attached pictures for raw data, calculations, and a summarizing plot

Conclusions:

Over a 2 week time course, both conditions of GelMA hydrogels maintained high encapsulated cell viability up until the drop-off at the 2 week mark. 

Nick Herbst - Apr 27, 2024, 1:18 PM CDT
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 02/08/2024 - Preliminary Presentation

Title: Preliminary Presentation

Date: 02/08/2024

Content by: Everyone

Present: Everyone

Goals: Present our design project progress thus far to our advisor

Content:

- See attachment for full presentation slides

Action items:

- Work to meet project goals

Nick Herbst - Feb 28, 2024, 1:49 PM CST

Download
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 02/28/2024 - Preliminary Report

Title: Preliminary Report

Date: 02/28/2024

Content by: Everyone

Present: Everyone

Goals: Compile our work thus far into a journal article manuscript draft and outline areas that will be filled in later

Content:

- See attachment for full report

Action items:

- Work to meet project goals

Nick Herbst - Feb 28, 2024, 1:50 PM CST

Download

BME_402_Preliminary_Report_.pdf (9.32 MB)
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 02-19-2024 DAPI Cell Adhesion assay in GelMA hydrogels

Title: Cell Adhesion Assay

Date: 02-19-24

Content by: Carley

Present: Self

Goals: To look at cheaper cell adhesion assay options

Content:

Nichol, J. W., Koshy, S. T., Bae, H., Hwang, C. M., Yamanlar, S., & Khademhosseini, A. (2010). Cell-laden microengineered gelatin
methacrylate hydrogels. Biomaterials, 31(21), 5536–5544. https://doi.org/10.1016/j.biomaterials.2010.03.064

https://www.ncbi.nlm.nih.gov/pmc/articles/PMC2878615/

For cell adhesion studies, square hydrogel sheets (1 cm (w) × 1 cm (l) × 750 μm (h)) were prepared in a similar manner as that used for
mechanical testing onto TMSPMA glass slides. Slides were covered with a HUVEC suspension containing 2.5×105 cells/mL to a depth of
approximately 1 mm above the surface of the GelMA hydrogel and incubated for 12 h prior to washing twice with DPBS. Media was
changed every 12 h for 5 days. GFP fluorescence was visualized using an inverted fluorescence microscope (Nikon TE 2000-U) equipped
with a GFP filter cube. GFP images were used to quantify total cell area using NIH ImageJ software. After 5 days, cells were fixed and
stained with rhodamine-phalloidin (Invitrogen) and DAPI to visualize F-actin filaments and cell nuclei respectively. Total cell number was
quantified using ImageJ by counting DAPI stained nuclei.

NIH 3T3 fibroblasts were trypsinized and resuspended in GelMA macromer containing 0.5% (w/v) photoinitiator at a concentration of
5×106 cells/mL. Microgel units (500 μm × 500 μm) were fabricated as previously described [15] following exposure to 6.9 mW/cm2 UV light
(360–480 nm) for 15 s on TMSPMA treated glass. The glass slides containing microgels were washed with DPBS and incubated for 8 h in
3T3 medium under standard culture conditions. A calcein-AM/ethidium homodimer Live/Dead assay (Invitrogen) was used to quantify cell
viability within the microgels according to the manufacturer’s instructions.

Conclusions/action items:

It seems that if we want to look at the cell adhesion on the surface we could use DAPI to visualize cell nuclei but doing embedded cell encapsulation
measurements may require a calcein based live/dead assay 

CARLEY SCHWARTZ - Feb 19, 2024, 12:44 PM CST
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 2024/02/26 Introduction research for paper

Title: Introduction research for paper 

Date: 02/26/24

Content by: Carley

Present: Self

Goals: To provide better motivation and conceptualize the purpose of the project 

Content:

Nizamoglu, M., Joglekar, M. M., Almeida, C. R., Larsson Callerfelt, A. K., Dupin, I., Guenat, O. T., Henrot, P., van Os, L., Otero, J.,
Elowsson, L., Farre, R., & Burgess, J. K. (2023). Innovative three-dimensional models for understanding mechanisms underlying lung
diseases: powerful tools for translational research. European respiratory review : an official journal of the European Respiratory
Society, 32(169), 230042. https://doi.org/10.1183/16000617.0042-2023

Developing appropriate treatments for chronic lung diseases can be bolstered through thorough understanding of disease
mechanisms. In spite of the abundance of and advancement in knowledge, the pathogenesis and progression of most chronic
diseases remains unclear. Much knowledge has been obtained from rodent studies, which often do not completely recapitulate
human diseases.
Traditional two-dimensional (2D) in vitro cell culture approaches have played a fundamental role in advancing current
knowledge of cell behaviour and fate. However, these approaches lack a range of essential cell–cell and cell–extracellular
matrix (ECM) interactions that have been shown to define cell signalling and function.

Conclusions/action items: Wanted to review some literature to aid in the motivation section of the our paper, specifically I wanted
to read some material on the motivation behind a 3D model.  
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 2024/28/02 - Human lung physiology

Title: Reviewing human lung physiology

Date: 02/28/24

Content by: Carley

Present: Self

Goals: Understanding the physiology of the lung and adding more to the introduction of our paper

Content:

Miller, A. J., & Spence, J. R. (2017). In Vitro Models to Study Human Lung Development, Disease and Homeostasis. Physiology (Bethesda,
Md.), 32(3), 246–260. https://doi.org/10.1152/physiol.00041.2016

Animal models have been instrumental in our understanding of lung development and disease. However, given many
differences between animal and human lung physiology, there is an unmet need for human lung model systems that can
complement animal models to improve our understanding of human lung physiology.
Mechanistically, influences such as biomechanical forces, availability of oxygen, morphogen signaling, and molecular-level
regulation of gene and protein expression work together to regulate lung development, homeostasis, and regeneration.
In the alveolar lung-on-a-chip, structural, functional, and mechanical elements of the interface between the alveoli and the
capillary network were modeled by micro-fabricating a microfluidic device that contains two channels separated by a thin
flexible membrane coated with ECM proteins. Vascular endothelial cells were cultured in one chamber, and alveolar epithelial
cells in the other, which could also be exposed to air.

Conclusions/action items: This article gave a great review for why disease models are necessary and how engineered scaffolds
are useful to replicate this. 

 

CARLEY SCHWARTZ - Feb 28, 2024, 6:50 PM CST
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Title: Bioprinter protocol (extreme detail)

Date: 01/30/24

Content by: Carley Schwartz

Present: Self

Goals: To create a very detailed protocol for other group members

Content:

Materials:

1. GelMA in amber cartridge from fridge 

2. CELLINK Bioprinter 

1. Temperature controlled printhead attachment 

2. Temperature maintaining nozzle attachment 

3. 22 gauge nozzle attached to cartridge (Many incase of clog) 

1. Smallest needle for declogging 

4. Pressure hose 

5. Luer lock connections

6. Petri dish

 

Method:

1. Place the GelMA cartridge into the connected temperature controlled print head 

2. On the bioprinter interface select the type of print you would like to conduct, in our scenario we will be doing a structured print 

1. ​Go to bioprint -> Simple shapes -> scroll down to cylindrical and select the 3x06mm.stl

2. Go to surface -> select your surface (for us petri dish) 

3. Printer -> tool 1 (or whichever you are using/what the print head is connected to) -> tool type: temperature
controlled ; temperature: 37 degrees to make a liquid 

1. ​At this point place the GelMA cartridge with a 22 gauge nozzle and the tube attached to the machine 

2. Once the time has passed pull the cartridge out and move it up and down to make sure it is a liquid 

4. Bioink profile: Cellink GelMA 1

5. Pre-flow: 100 ms 

6. Photocrosslinking: 405 nm 

3. Layers

1. Select concentric for infill pattern

2. For infill density select 35%

4. On the Print screen

1. Press the settings symbol and go to Tools - for temperature change to printing temp (27) and wait for 15 minutes
for it to equilibrate 

CARLEY SCHWARTZ - Feb 08, 2024, 11:20 AM CST
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5. Once in the print screen -> go to the print option which will then take you to calibration ​

6. Calibrate first with be leveling and the probe in the back

7. Next manual calibration to provide the printer information on how far you want the nozzle to be from the dish while printing and
in what region of the dish 

1. ​UV light requires it to be in the back half 

8. Now the machine should be ready to print but you should check to make sure there are no bubbles in the cartridge nozzle by
flicking and make sure the tip isn't clog with one of the cell link needles 

9. Then you press start to do the print trial

1. ​If issues arise adjust the temperature, extrusion pressure, declog the nozzle or flick the tube 

2. If continual issues you can test the extrusion pressure with test flow but avoid doing this as it wastes a lot of
product!!!

Conclusions/action items: As the semester continues more details will be added based on UV time and distance for fibrotic and healthy states. 
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 Hydrogel Drying Methods

Title: Drying and Storage Effects on Poly(ethylene glycol) Hydrogel Mechanical Properties and Bioactivity

Date: 1-31-24

Content by: Elijah Diederich

Present: Myself

Goals: To determine methods of drying hydrogels that are widely accepted to apply to our design

Content:

Citation: [1] P. T. Luong, M. B. Browning, R. S. Bixler, and E. Cosgriff-Hernandez, “Drying and storage effects on poly(ethylene glycol) hydrogel
mechanical properties and bioactivity,” Journal of biomedical materials research. Part A, https://www.ncbi.nlm.nih.gov/pmc/articles/PMC3972368/
(accessed Jan. 31, 2024). 

 
Abstract:

Note that PEG-diacrylate hydrogels are being used in this study exploring the mechanical properties and swelling effects using different
hydrogel drying processes. 
The 3 drying procedures used in this article include vacuum-drying, lyophilizing, and hydrating-->vacuum drying

Methods:

First method of drying that was introduced was a hydration in water followed by vacuumdrying at -30 psi.
Second method of drying was strictly a vacuum drying without the hydration process in the beginning
Third method of drying was flash-freezing in liquid nitrogen followed by vacuum drying

- Swelling ratio was calculated by taking the equilibrium swelling mass and dividing it by the dry polymer mass (post-vacuum drying)

- Ws/Wd is the equation for what is described above

- Ws (in this particular study): Discs were processed, soaked in water for 24 hrs and weighed to measure the equilibrium swelling mass (Does this
have be water? Or can we use PBS, which is what we are currently using)

- Wd: After obtaining Ws weight, gels were then vacuum-dried for 24 hrs and a Dry polymer mass was taken. 

 

Conclusions/action items:

1. Look into vacuum drying (what setup, availability etc...)

2. Continue to look for articles about leaving the hydrogel in the open over extended periods of time. 

3. Rheology measurements for made gels
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Title: 3D in vitro hydrogel models to study the human lung extracellular matrix and fibroblast function

Date: 02/26/2024

Content by: Caitríona 

Present: N/A

Citation: Phogat, S., Thiam, F., Al Yazeedi, S., Abokor, F. A., & Osei, E. T. (2023). 3D in vitro hydrogel models to
study the human lung extracellular matrix and fibroblast function. Respiratory research, 24(1), 242.
https://doi.org/10.1186/s12931-023-02548-6

Goals: To document research on existing models to be included in the report. This article is a review of various studies
that used 3D models to assess the regulation of the ECM on lung fibroblast phenotype and function in altered lung ECM
homeostasis in health and in chronic respiratory disease. 

Content:

"During lung injury and in chronic lung diseases such as asthma, idiopathic pulmonary fibrosis (IPF) and
chronic obstructive pulmonary disease (COPD), an abnormal feedback between fibroblasts and the altered
ECM disrupts tissue homeostasis and leads to a vicious cycle of fibrotic changes resulting in tissue
remodeling." 
Lung ECM is recognized as having a bioactive role in physiological and pathological processes. The lung
ECM supports the phenotype and function of fibroblasts, among other cells, via biochemical and micro-
architectural cues that create signaling niches and provide positional instructions. The lung fibroblast-ECM
interactions become abnormal in various lung diseases. 
In most traditional research, two-dimensional monolayer cell-culture systems which are simple and high
throughput allow for the study of mechanisms behind increased expression of ECM proteins by fibroblasts in
various pathological conditions. These models, however, restrict and do not accurately represent the
complex cellular-ECM lung microenvironment. Data is deceptive, but used to inform animal studies. 
In order to mimic the complexities of the 3D relationship between pulmonary ECM and lung fibroblasts, it is
essential to establish 3D hydrogel models which embed cells in configurations characteristic of the temporal,
spatial and cell type specific connections found in the in vivo lung environment.  
Advancements in 3D hydrogel models have enabled the assessment of the effect of the lung's 3D ECM
microenvironment on fibroblast phenotype and function in tissue homeostasis and disease. 
3D Hydrogel Culture Models: Hydrogels are crucial for building 3D in vitro models due to their similarities to
the native ECM in the human body. They are an interconnected 3D network of hydrophilic polymers with the
capacity for cellular encapsulation or surface seeding on top of the microfilaments to form a micro-gel.
Collectively, they offer new routes to study and experiment with cellular mechanisms in four dimensions
(cellular functions in three dimensions against time as the fourth). Through 3D hydrogels, it was established
that the lung ECM fundamentally affects cellular behavior and function. In lung research, the two main types
of hydrogel scaffolds are natural hydrogels and synthetic hydrogels. 

Natural polymer hydrogels: Prominent bioactive features that allow them to interface favorably
with cells. Within natural hydrogels, the two main types are protein and polysaccharide-based
hydrogels. Collagen is the most widely used natural polymer for building 3D hydrogel systems.
Most collagen scaffolds are prepared using type I collagen and can be easily modifies by cross-
linking. Matrigel is another commonly used natural hydrogel, composed mainly o collagen IV,
glycoproteins and various growth factors in the basement membrane protein. It is thermo-
sensitive and used widely for cell (co-)cultures, bioprinting and tissue engineering to support
independent epithelial cell culture and their co-culture with other cell types such as fibroblasts.
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Gelatin methacrylate (GelMa) is another natural ECM mimicking polymer commonly used
for building 3D hydrogel models. It is a protein-based polymer manufactured by reacting
methacrylic anhydride (MA) with gelatin (naturally occurring hydrolyzed derivative of
collagen). Hyaluronic acid (HA) is another important component of connective tissues. HA can
be chemically modified by radical polymerization into soft or stiff hydrogel scaffolds. Alginate is
another natural polysaccharide that is commonly used in 3 hydrogel system construction
because of its rapid cross-linking property (through exposure to calcium chloride). Another form
of natural hydrogel scaffolds are those sourced from the ECM through allogeneic or xenogenic
lung decellularization (usually through perfusion of detergents or salt solutions). Although this
method has the advantage of cellular environment retention to allow for inherent biological
activity of the natural matrix, cellular growth and constructive tissue remodeling, a major
disadvantage is the challenge of ECM structure damage due to decellularization detergents. A
major advantage of natural polymer application to 3D hydrogel models is their bio-active
features (cell-adhesion motifs, non-immunogenicity, non-inflammatory, biodegradability).
They also make it easy to integrate peptide ligands and cell membrane receptors through
covalent bonding that stimulates adhesion of cells with subsequent spreading and
proliferation. However, natural polymer hydrogels have poor mechanical strength and low
stability when compared to synthetic polymer-based hydrogels. 

Synthetic polymer hydrogels: Offer better mechanical properties (PEG and PA), such as strength and
stability of the native lung tissue, but tend to lack biological active features. They often offer better control
over structure and property that help to ensure replicability of lung tissue architecture. PEG (polyethylene
glycol) and PA (polyacrylamide) are two of the most commonly used synthetic molecules for 3D cell culture.
PEG had minimum protein absorption, is hydrophobic, and has cross-linking chemistry that is easily
modified. Its main applications are in studying changes in cell behavior due to changes in matrix stiffness, as
is the case in fibrotic vs healthy tissue. PA hydrogels are popular in cell mechanical studies due to the ability
of high-resolution cell imaging through their transparent structure as well as the ability to customize their
stiffness and surface functionality. Synthetic polymers are inert and do not have any effect on cellular
activity. Therefore, they are often combined with a bioactive material in order to increase
biocompatibility parameters. 
When recreating a three-dimensional environment, it is often not enough to use a single polymer hydrogel.
In some tissue models, it is necessary to use a composite or hybrid hydrogel with more than one polymer to
fully meet the functional and structural characteristics of the native ECM. These composites overcome the
weak mechanical properties of natural scaffolds while at the same time providing bioactive components to
the ECM to modulate cell behavior. Common composite hydrogels: GelMa/PEG, alginate-PA, collagen-
PA. Hydrogel models have successfully mimicked the physical and mechanical properties of the healthy vs
diseased ECM, allowing for exploration of how lung fibroblasts and other cells are affected by changes that
occur in their 3D environment. 

Specific models that have been developed:

Marinkovic et al. studied how mechanical properties of the matric impacted fibroblast contractility. PA
hydrogels of stiffnesses ranging from 0.3-20 kPa were prepared and conjugated with fluorescent
microsphere beads. Gels were seeded with IMR-90 lung fibroblast cell lines, either in the presence or
absence of TGF-β1 fibrotic mediator treatment. Traction measurements determined that lung fibroblasts
exert lower forces on softer matrices as opposed to greater forces on stiffer matrices. Differences in smooth
muscle actin expression on stiffer matrices also suggested an interaction between stiff lung ECM
environment and fibrotic mediators, in fibroblast force generation, and FMT. 
Liu et all. engineered a collagen I functionalized PA 3D hydrogel matrix system with a 1D gradient of shear
modulus ranging from 0.1 to 50 kPa. CCL-151 lung fibroblast cell lines were seeded and significant changes
in CCL-151 lung fibroblast morphology (attenuated round cells at lower stiffness to spindle shaped with
dendrites on intermediate, and parallel swirls of spindle-shaped cells at higher stiffnesses). Reported a
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stiffness-dependent suppression of cyclooxygenase-2 (COX-2) expression and synthesis of prostaglandin
E2 during fibrogenesis. 
Brown et al. found contradicting results through the use of a PA model that showed that increased epithelial
cell contractility on stiff matrices causes integrin-mediated TGF-β activation and EMT and that abnormal
EMT-derived  mesenchymal cells have the potential to revert back to their normal phenotype if the fibrotic
stimulant is reversed. 
In 2019, Fu et al. engineered a novel protein-based hydrogel with cyclic and reversible mechanics that tuned
a large range of stiffnesses (6 kPa and 20 kPa) via glutathione. Cell culture medium was switched between
the oxidizing and reducing state in a cyclic manner to study how lung fibroblasts respond to continuously
changing hydrogel mechanics. In oxidizing conditions, human lung fibroblasts (HLF) changed morphology
and went from a high cell spread state to a low cell spread state, leading to a significant increase in the cell
area, accompanied by a slight decrease in cell roundness. The opposite was observed when conditions
returned to a reducing state. This suggests that HLFs have the ability to continuously sense hydrogel
stiffness and produce a fully reversible and dynamic mechanoresponse through behaviors such as cell
morphology and phenotype. 

Conclusions/action items: Use the above information to contribute to the 'existing research' portion of the
preliminary draft of the journal article. 
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02/28/2024 ADDITION: 01/06/2024 Synthesis and Properties of
Gelatin Methacryloyl

Title: Synthesis and Properties of Gelatin Methacryloyl (GelMA) Hydrogels and Their Recent Applications in Load-Bearing Tissue 

Date: 01/03/2024, 02/28/2024

Content by: Anuraag

Present: Self

Goals: Understand why the pipette-based hydrogels exhibited shrinking after being submersed in culture media or an aqueous solution.

Content:

Evaluation of Swelling Property: The swelling property of GelMA hydrogels was assessed using a weighing method. Samples were prepared,
freeze-dried, and then soaked in a solvent (such as ultrapure water or pH 7.4 PBS) at intervals. The swelling ratio was calculated using a specific
formula, allowing for analysis of the swelling behavior.

Influence of GelMA Concentration and Degree of Substitution: Studies, including one by Nichol JW et al., explored how GelMA concentration and
the degree of substitution affect swelling ratios. Results indicated that higher degrees of substitution led to decreased swelling ratios, and increasing
GelMA concentration resulted in decreased swelling, likely due to increased crosslink densities.

Role of Hydrogels in Biomedical Applications: Hydrogels, possessing three-dimensional hydrophilic polymer networks, have tunable properties
crucial for various biomedical applications such as tissue engineering, regenerative medicine, and drug delivery. Their similarity to the natural
extracellular matrix makes them favorable for in vitro cell culture.

Types of Hydrogels: Hydrogels are categorized into natural and synthetic types. Natural hydrogels offer better biocompatibility compared to synthetic
ones, enhancing cellular viability, multiplication, differentiation, and locomotion.

Limitations of GelMA Hydrogel in Bone Tissue Engineering: Despite its advantages, GelMA hydrogel's mechanical strength limits its application in
bone tissue engineering. Various strategies, such as incorporating rigid materials like gellan gum methacrylate (GGMA) or hydroxyapatite (HAP),
have been explored to improve its mechanical properties.

Strategies for Enhancing Mechanical Strength: Strategies include preparing double-network (DN) hydrogels, mixing GelMA with HAP, or combining
GelMA with PEGDA. Additionally, using microfibre networks or poly(ɛ-caprolactone) (PCL) fiber scaffolds, and covalent binding between gel and
scaffold, have been shown to enhance mechanical strength.

Reasons for Observing Shrinking:

Material Composition: Changes in the composition of hydrogels, such as altering GelMA concentration or degree of substitution, can influence their
swelling behavior.

Crosslink Density: Increased crosslink densities, as seen with higher GelMA concentrations, can lead to decreased swelling ratios.

Environmental Factors: Exposure to different solvents or solutions can induce swelling or shrinking behavior in hydrogels, impacting their overall
properties.

Sun M, Sun X, Wang Z, Guo S, Yu G, Yang H. Synthesis and Properties of Gelatin Methacryloyl (GelMA) Hydrogels and Their Recent Applications in Load-Bearing
Tissue. Polymers. 2018; 10(11):1290. https://doi.org/10.3390/polym10111290

Yin H, Zhu M, Wang Y, Luo L, Ye Q and Lee BH (2023) Physical properties and cellular responses of gelatin methacryloyl bulk hydrogels and highly ordered porous
hydrogels. Front. Soft. Matter 2:1101680. doi: 10.3389/frsfm.2022.1101680

 

Conclusions/action items: Adjusting the cross-linking time may contribute to better swelling behavior as cross-linking density is a factor that can be addressed by
the group when making more gels in the future.
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 UPDATED_05/01/2024_04/22/2024_Welch's T-test

Title: Welch's T-Test

Date: 04/22/2024

Content by: Anuraag

Present: N/A

Goals: Find a way to show that there is no difference between the two groups to quantify LIVE/DEAD.

Content: 

Validity of t-test:
The t-test is suitable when data are normally distributed or when there are at least 50 measurements and the distribution is
reasonably symmetric.
Formal testing for normality, such as the Shapiro-Wilks test, is not necessary, especially with large sample sizes, as the t-
test is robust against departures from normality if the distribution is not heavily skewed.

Equal standard deviations:
The original Student's t-test assumes equal standard deviations between groups, but the Welch t-test is preferred as it
allows for different standard deviations.
The Welch t-test is practical because it's often difficult to ensure equal variances in real-world data, and it provides similar
power to Student’s t-test.

Non-parametric test:
The Mann–Whitney U-test (or Wilcoxon rank-sum test) can be used if there's doubt about the symmetry or normality of the
data.
This test is distribution-free and compares the ranks of measurements rather than the measurements themselves.

Example:
An example provided in the article demonstrates the application of both the t-test and the Mann–Whitney U-test on two
groups with different means and standard deviations.
It shows how the choice of test can affect the resulting p-values and emphasizes the importance of selecting an
appropriate test based on data characteristics.

Summary:
The Welch t-test is preferred over Student’s t-test when assumptions of normality are met or nearly met, while the Mann–
Whitney U-test is a robust alternative when normality assumptions are violated.
The Welch t-test tests for differences in means, whereas the Mann–Whitney U-test tests for differences in medians.

Source:
West RM. Best practice in statistics: Use the Welch t-test when testing the difference between two groups. Annals of Clinical Biochemistry.
2021;58(4):267-269. doi:10.1177/0004563221992088

Conclusions/action items:

Move forward with Welch's t-Test as we are measuring differences in means with an assumption of normality.
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 02/28/2024 Lab Safety Documentation

Download

Screenshot_2024-02-28_143836.jpg (73.9 kB)
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 03/15/2024 Tong Lecture

Title:  Tong Lecture

Date: 03/15/2024

Content by: Anuraag Shreekanth Belavadi

Present: N/A

Goals: N/A

Content:

Exact Sciences

- 1995: Stan Lapidus in partnership with Ed Kania at Flagship Ventures

- Idea of screening for colon cancer from a stool sample

2002: Went public and raised 56M in IPO

- Entered exclusive agreement with LabCrop to distribute the test

2004: Poor efficacy as results of a large prospective clinical trial were published in the New England Journal of Medicine

2009: Clinical Problem, enormous market opportunity

- 80 million Americans over 50, 60% unscreened

Numerous Business Considerations were identified in conjunction with technology development

- Prospective clinical data

- FDA approval

- Commercial Launch

- CMS reimbursement

- Guidelines

Keys to Success

- Clinical Utility

- Regulatory landscape, reimbursement, economic activity

- Team Culture

Conclusions/action items:
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 01/26/2024 Identifying Potential Journals

Title: Identifying Potential Journals

Date: 01/26/2024

Content by: Nick Herbst

Goals: Look for potential journals we should select for our final report

Content:

Biomaterials Science
link: https://www.rsc.org/journals-books-databases/about-journals/biomaterials-science/
Impact Factor: 6.6
"journal exploring the science of biomaterials and their translation towards clinical use"

Biomaterials
link: https://www-sciencedirect-com.ezproxy.library.wisc.edu/journal/biomaterials
Impact Factor: 14
"...journal covering the science and clinical application of biomaterials..."

ACS Biomaterials Science and Engineering
link: https://pubs-acs-org.ezproxy.library.wisc.edu/page/abseba/about.html
Impact Factor 5.7
"...journal scope...characterization, synthesis, and modification...new biomaterials...biomimetic approaches to
biomaterials..."

Tissue Engineering Part A
link: https://home.liebertpub.com/publications/tissue-engineering-part-a/263
Impact Factor: 4.1
"...journal for groundbreaking research on all aspects of tissue growth and regeneration including broad-ranging coverage
that spans bioengineering..."

Conclusions:

I found these journals by looking at the journals our sources are from. Any of these would likely work, but we will need to discuss it as a team to select
one. 
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 02/03/2024 Biomaterials Science Journal

Title: Biomaterials Science Journal 

Date: 02/03/2024

Content by: Nick Herbst

Goals: Learn more about the journal we chose

Source: https://www.rsc.org/journals-books-databases/about-journals/biomaterials-science/ 

Content:

Biomaterials Science is the journal we chose to "submit" our project to
Impact factor of 6.6
The journal has no specific guidelines for submitted papers because they have professional editors that edit and typeset the paper to
match their "house style" for the final publication
They provided a template that has the following sections

Title
Authors

Have superscript with affiliations for all authors
Abstract

single paragraph that summarizes paper content
Body

up to 3 levels of headings
"A" headings are largest and for primary heading types

Introduction
Results and Discussion (one section)
Experimental

"B" headings are subordinate to "A" headings
Materials under Experimental
Methods under Experimental
Specific things like Hydrogel Characterization under Results and Discussion

"C" headings are subordinate to "B" headings
Specific things like Bioprinted Hydrogel Fabrication under Methods under Experimental

Conclusions
Author Contributions

They have a link for authorship guidelines embedded in the template
Conflicts of Interest

if no conflicts of interest, state so
Would we have a conflict of interest because we are doing this for a grade????

Acknowledgements
Footnotes and References

Citations should be in this format
A. Name, B. Name and C. Name, Journal Title, 2020, 35, 3523

The journal prefers citations from primary research over review articles 
See attached for the template

Conclusions:

After meeting, the team decided on the Biomaterials Science Journal. Since our final manuscript must be in the format of the journal's standards, I felt
it prudent to learn what these standards are. I will inform the team that we should look at papers from this journal to get a feel for the guidelines
because the journal has no guidelines since they have in-house editors. 
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 02/03/2024 Cell Viability Assays in 3D Hydrogels

Title: Cell Viability Assays in 3D Hydrogels

Date: 02/03/2024

Content by: Nick Herbst

Goals: Re-review methods of determining the viability of cells embedded in hydrogels

Source: J. J.-M. Su, C.-H. Lin, H. Chen, S.-Y. Lee, and Y.-M. Lin, “Biofabrication of Cell-Laden Gelatin Methacryloyl Hydrogels with Incorporation of
Silanized Hydroxyapatite by Visible Light Projection,” Polymers (Basel), vol. 13, no. 14, p. 2354, Jul. 2021, doi: 10.3390/polym13142354.

Content:

This paper made a GelMA-hydroxyapatite composite hydrogel to increase the mechanical properties of the gel and embedded
osteoblasts and MSCs into the hydrogel for bone tissue engineering

I focused on how they quantified cell viability
Of important note, they used 1% VA-086 (visible blue light) as the photoinitiator instead of 0.25% LAP (UV
photocrosslinking) to reduce cytotoxicity

This group use LIVE/DEAD staining for cell viability
Gels had a diameter of 6.4mm and a height of 5mm (almost 3 times the volume of our gels) and were seeded with 1e6 -
1e7 cells/mL
5uL of calcein AM and 20uL of ethidium homodimer-1 were added to 10mL of PBS to make the staining solution
The cell-laden gels were washed with PBS twice then 200uL of the staining solution was added to each well with a gel in
the culture plate 
The gels were incubated with the staining solution for 30min and then fluorescent images were taken under a fluorescence
microscope

See attachment for the full paper

Conclusions:

One of the key takeaways from the end of last semester was that we needed to find another method for quantifying cell viability since the LIVE/DEAD
(calcein/ethidium) staining gave unusable results. After reviewing many papers, I have found that the method we used is the most common method of
quantifying cell viability for cells embedded in hydrogels. I very strongly believe that this method did not work for us last semester due to errors in
methodology. No concrete/established protocol was followed for the calcein/ethidium staining. I believe that we need to try again using this method and
follow a protocol. Also, we potentially need to a get new/fresh LIVE/DEAD kit from Thermofisher (catalog no. R37601, $300 for a kit with 10 of each
dye)
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 02/27/2024 Cell Culture Troubleshooting

Title: Cell Culture Troubleshooting

Date: 02/27/2024

Content by: Nick Herbst

Goals: Look into troubleshooting tips for cell culture issues

Source: “Poor Cell Growth Troubleshooting.” Accessed: Feb. 27, 2024. [Online]. Available: https://www.sigmaaldrich.com/US/en/technical-
documents/technical-article/cell-culture-and-cell-culture-analysis/mammalian-cell-culture/poor-cell-growth

Content:

No or few viable cells after thawing
Stock was possibly thawed incorrectly

thaw rapidly, use pre-warmed media, remove cryoprotectant ASAP, don't centrifuge at high speeds
Poor cell attachment

static electricity build up on TCP flask
increase room humidity (maybe room is dry since it is winter??), wipe outside of flask with damp towel

cell and media mixing is inadequate
mix better

Slow cell growth
media is poor quality

use new media
too many passages

use stock of cells that have lower passage number
cells were too confluent at time of passage (contact inhibition)

passage at 80% confluency
CO2 levels aren't right so pH is wrong

check incubator settings
fluorescent room lights cause media components to convert to free radicals

store cells and media in the dark
Uneven cell growth

cell and media mixing is inadequate
mix better

See attachment for PDF of webpage

Conclusions:

Since Will thawed the 3T3 fibroblasts for use in our project, we have been having multiple issues. The first thawing yielded no viable cells, and the
second thawing yielded very few viable cells. When these very few cells were expanded, it took a very long time and the cells proliferated unevenly
with some regions of the flask reaching confluency while other regions were sparse. In light of these struggles I looked into cell culture troubleshooting
tips. It has been a while since I have thawed cells and maintained cell culture, so I will have to check with Will to know what exactly he did so I can
help determine what the issue is. 

Nick Herbst - Feb 27, 2024, 12:25 PM CST

Nick Herbst/Research Notes/02/27/2024 Cell Culture Troubleshooting 133 of 149

https://www.labarchives.com/


Download

Poor_Cell_Growth_Troubleshooting.pdf (1.54 MB)

Nick Herbst - Feb 27, 2024, 11:52 AM CST

Nick Herbst/Research Notes/02/27/2024 Cell Culture Troubleshooting 134 of 149

https://mynotebook.labarchives.com/share_attachment/BME%2520Design-Spring%25202024%2520-%2520ELIJAH%2520DIEDERICH/MTE5LjYwMDAwMDAwMDAwMDAxfDEwMzMxOTkvOTItNzcvVHJlZU5vZGUvMjMyMzI4Mjg0fDMwMy41OTk5OTk5OTk5OTk5Nw==
https://mynotebook.labarchives.com/share_attachment/BME%2520Design-Spring%25202024%2520-%2520ELIJAH%2520DIEDERICH/MTE5LjYwMDAwMDAwMDAwMDAxfDEwMzMxOTkvOTItNzcvVHJlZU5vZGUvMjMyMzI4Mjg0fDMwMy41OTk5OTk5OTk5OTk5Nw==


 03/08/2024 Identifying a Full LIVE/DEAD Staining Protocol

Nick Herbst/Research Notes/03/08/2024 Identifying a Full LIVE/DEAD Staining Protocol 135 of 149

https://www.labarchives.com/


Title: Identifying a Full LIVE/DEAD Staining Protocol

Date: 03/08/2024

Content by: Nick Herbst

Goals: Re-re-review literature to get a more fleshed-out LIVE/DEAD staining protocol for use in 3D hydrogels

Sources: 

Molecular Probes, “LIVE/DEAD Viability/Cytotoxicity Kit.” [Online]. Available:
https://tools.thermofisher.com/content/sfs/manuals/mp03224.pdf
S. Matsos, “Live/Dead Quantification Using Fiji - Step-by-Step Guide | Suuport,” Allevi. Accessed: Mar. 08, 2024. [Online]. Available:
https://www.allevi3d.com/livedead-assay-quantification-fiji/ 

Content:

Notes from Molecular Probes, Inc.'s LIVE/DEAD kit protocol
 Calcein AM and Ethidium homodimer-1 Storage

Store in a -20 ºC freezer
Protected from light

Either kept in a box or wrap vials in foil
Before using the stock solutions, allow them to thaw to RT and centrifuge them briefly before opening them

Fluorophores can aggregate overtime
Calcein AM hydrolyzes when exposed to moisture, so be sure to keep it away from water (stock solution is in
anhydrous DMSO)

Aqueous working solutions of calcein AM should be prepared immediately prior to use and
must be used within one day
Ethidium homodimer-1 is not sensitive to moisture; Aqueous working solutions of it can be
stored at -20 ºC for up to one year

Before refreezing stock solutions, seal all vials tightly 
Optimal Concentration Determination 

Note that the source says 2 μM calcein and 4 μM ethidium works for 3T3s
Prepare samples of live and dead cells

Can get the dead cells by killing cells with 70% methanol for 30 min
Use a sample of dead cells to optimize the EthD-1 concentration

Dilute the ethidium in PBS to varying concentrations and see the lowest conc that stains the
dead cell nuclei bright red with minimal cytoplasmic staining
Try diluting to 0.1 - 10 μM

Use a sample of dead cells to start to optimize the calcein AM concentration
Dilute the calcein in PBS to varying concentrations and see the lowest conc which gives
minimal cytoplasm staining
Try diluting to 0.1 - 10 μM

Use a sample of live cells to confirm the optimization of the calcein AM concentration
Dilute the calcein in PBS to the same conc used in the prior step and see if that gives a
sufficient green stain in live cells
If not, try a higher concentration

Important Notes
Calcein AM is calcein acetoxymethylester, and it functions by permeating live cell plasma membranes and
then getting hydrolyzed by intracellular esterases which releases the fluorescent calcein

Cells need to be washed with PBS prior to LIVE/DEAD staining because media can have
esterases which hydrolyze the calcein AM and cause extracellular fluorescence

This could be the source of one of our issues! We may just need to wash the
cells/gels more

Dim the lights of the work space and have cells covered in foil when not actively adding something or
imaging

The fluorescent dyes are photosensitive
Notes from Allevi's LIVE/DEAD ImageJ protocol

Need to split the images into respective channels
Image > Color > Split Channels
Gives 3 gray-scale windows labelled with their channel names

Close blue, keep red and green
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Change the images to 8-bit by Image > Type
Clean up the images

Eliminate background noise with Image > Adjust > B/C and move minimum bar to the right until image is
cleaner without losing important signals

Moveing the maximum bar to the left may also help to increase staining intensity
Hit "Apply" when done and then repeat for other channel

Keep B/C settings constant between different images of the same channel
(all green should have same settings and all red should have same settings, but
green and red don't have to have the same settings)

Live/dead cell counting is done with image segmentation
convert grey-scale to binary by Image > Adjust > Threshold then drag top bar to highlight only the stained
cells in red

Too high a threshold looses signal and too low threshold fuses cells for reduced count
Hit "Apply" when done to get cells as white w a black background and then repeat for other
channel

Split fused cells with Process > Binary > Watershed
Analyze > Set Measurements > check Area
Analyze > Analyze Particles

If there is a lot of background noise still after processing, set a minimum particle size in pixel
units
Check Add to Manager then Ok
Window > ROI Manager

Find a ROI of a cell that is small but still a stained cell then hit measure in the
manager window to get the Area

Rerun Analyze Particles and use a number slightly smaller than the small cell area as the
minimum particle size in area units

Dead cells are smaller than live cells so can't use same min measurement for
both channels

Record how many ROIs there are for that channel
In ROI Manager click one ROI then do ctrl+A then Measure which gives data of
area of all ROIs as well as ROI count

REPEAT above steps for the other channel
First delete all ROIs from previous measurement bc ROI manager is global

Calculate % live cells by doing # green ROIs divided by sum of green and red ROIs then multiply by 100

Conclusions:

After preliminary LIVE/DEAD staining, we had background noise in the ethidium homodimer-1 stain and still had strange smearing in the calcein AM
stain (as if the GelMA hydrogel is getting stained). Our advisor says that our current LIVE/DEAD staining protocol is "bare bones." We need to include
information on troubleshooting and analysis, so I looked into the literature more. I found information on fluorescent dye concentration optimization and
storage, background noise troubleshooting tips, and ImageJ analysis. I plan to add onto our current protocol to include this information as well as
information on the RFP filter for ethidium homodimer-1 since the Nikon fluorescence microscope doesn't have a default RFP filter; Will needed to set
that filter up. I will then make a more formal protocol for the ImageJ analysis.
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 04/09/2024 LIVE/DEAD Stained Cell Survival Length

Title: LIVE/DEAD Stained Cell Survival Length

Date: 04/09/2024

Content by: Nick 

Present: Nick 

Goals: Find evidence in literature to support my belief that LIVE/DEAD staining is an endpoint and you can't put the stained cells back into culture to
image again later

Source: F. L. Miles, J. E. Lynch, and R. A. Sikes, “Cell-based assays using calcein acetoxymethyl ester show variation in fluorescence with treatment
conditions,” J Biol Methods, vol. 2, no. 3, p. e29, 2015, doi: 10.14440/jbm.2015.73.

Content:

calcein AM is a transient label
cells don't retain fluorescence after 24 hours

It is fluorophore so it is not stable in light, so the fluorescence decreases over time
After extended exposure it is cytotoxic to cells

Conclusions:

The other team members have proposed that we LIVE/DEAD stain our cell-laden hydrogels, image them, then add media again and keep the stained
cells in culture to image them again at later timepoints. I personally have very heavy doubts about this plan; I think that LIVE/DEAD staining is an end
point and stained cells will not survive in culture to be imaged at later timepoints. Some of my team is under the assumption that live cells that were
stained with calcein AM will lose their green fluorescence and stain with ethidium homodimer-1 once they die, and that since there is no fixing agent
the cells will survive extended culture. I have expressed my concerns to my teammates and suggested we make more cell-laden gels than planned so
we can culture them all and image subsets at different timepoints instead of imaging the same set of stained gels over and over. However, some of my
teammates are very confident that you can keep LIVE/DEAD-stained cells in culture to image again at a later time, so I set out to look for literature to
support my position. 

The majority of what I found was not from peer-review journals because I couldn't find anything; this leads me to believe that this issue isn't normally
found in literature because it is common practice use LIVE/DEAD staining as an endpoint. The majority of what I found was on discussion forums like
ResearchGate. I was able to find some peer-reviewed literature and listed the key points above. Overall, it looks like my thinking was correct in that we
can't put the stained cells back into culture and expect the staining to "update" when we image later. 
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 01/26/2024 Drying Hydrogels for Swelling Quantification

Title: Drying Hydrogels for Swelling Quantification

Date: 01/26/2024

Content by: Nick Herbst

Goals: Obtain evidence to support the idea that hydrogels can be air-dried for swelling quantification

Source: S. M. Bittner et al., “Swelling Behaviors of 3D Printed Hydrogel and Hydrogel-Microcarrier Composite Scaffolds,” Tissue Eng Part A, vol. 27,
no. 11–12, pp. 665–678, Jun. 2021, doi: 10.1089/ten.tea.2020.0377.

Content:

This paper goes into the swelling of 3D-printed hydrogel scaffolds
I only focused on the methods section that described how the authors quantified the swelling ratios of their hydrogels

The authors swelled their hydrogels in PBS and then measured the wet weight, then dried the gels and measured the dry weight, then
re-swelled the gels in PBS

They did multiple dry-swell cycles across different time points
To get the wet weight, the hydrogels were removed from the PBS, blotted to remove the surface water, and the weighed
To get the dry weight, the hydrogels were air-dried and then dried under a vacuum

See attachment for the full paper

Conclusions:

During our first advisor meeting while we were discussing things to do this semester, Carley brought up quantifying the swelling of our GelMA
hydrogels. Since the swelling ratio uses the dry weight and wet weight of a hydrogel, Carley suggested we lyophilize our hydrogels to dry them.
However, I remembered that we calculated swelling ratios in BME 430 by letting hydrogels air-dry (for 30 days). Thus I looked for a paper to support
the fact that we can air-dry our gels to get the dry weight. While it will take longer, this method requires no extra equipment.
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 02/09/2024 LIVE/DEAD Staining Protocol

Title: LIVE/DEAD Staining Protocol

Date: 02/09/2024

Content by: Nick Herbst

Present: Nick Herbst

Goals: Establish protocol for LIVE/DEAD staining

Content:

See attachment for protocol

Conclusions/action items:

Use this protocol to image the fibroblasts encapsulated in GelMA hydrogels. Cell viability can be determined by comparing the number of calcein AM
positive cells to the number of ethidium homodimer-1 positive cells

Nick Herbst - Feb 11, 2024, 3:06 PM CST
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Title: Improved LIVE/DEAD Staining Protocol

Date: 03/12/2024

Content by: Nick Herbst

Present: Nick Herbst

Goals: Rewrite protocol for LIVE/DEAD staining with more in-depth information

Content:

Materials: 

15mL conical tube
20μL pipette + tips
1000μL pipette + tips
10mL serological pipette
Phosphate-buffered saline (PBS)
Fluorescence microscope
LIVE/DEAD Viability Kit (Thermofisher) containing calcein AM and ethidium homodimer-1 (EthD-1)

Store in a -20 ºC freezer protected from light
Either keep the reagent vials in a box or wrap them in foil

Before using the stock solutions, allow them to thaw to RT and centrifuge them briefly before opening them
Fluorophores can aggregate overtime

Calcein AM hydrolyzes when exposed to moisture, so be sure to keep it away from water (stock solution is in anhydrous
DMSO)
Aqueous working solutions of calcein AM should be prepared immediately prior to use and must be used within one day
Ethidium homodimer-1 is not sensitive to moisture; Aqueous working solutions of it can be stored at -20 ºC for up to one
year
Before refreezing stock solutions, seal all vials tightly

Fluorescent Dye Concentration Optimization:

1. Prepare samples of live and dead cells

1. Dead cells can be obtained by killing cells with 70% methanol for 30min
2. Use samples of dead cells to optimize the EthD-1 concentration

1. Dilute the EthD-1 in PBS to varying concentrations, add the dilutions to dead cells, incubate for 30min, then image

1. Try diluting EthD-1 to 0.1 - 10μM
2. You want the lowest EthD-1 concentration which stains the dead cell nuclei bright red with minimal cytoplasmic staining

3. Use a sample of dead cells to start to optimize the calcein AM concentration

1. Dilute the calcein AM in PBS to varying concentrations, add the dilutions to dead cells, incubate for 30min, then image

1. Try diluting calcein AM to 0.1 - 10μM
2. You want the lowest calcein AM concentration which gives minimal cytoplasm staining

4. Use a sample of live cells to confirm the optimization of the calcein AM concentration

1. Dilute the calcein AM in PBS to the same concentration that used in the prior step, add it to live cells, incubate for 30min,
then image

2. See if the used concentration gives a sufficient green stain in live cells

1. If not, try a higher concentration on another sample of live cells

LIVE/DEAD Staining:

1. Use the serological pipette to add 10mL of PBS to the conical tube
2. Add enough calcein AM and ethidium homodimer-1 to the PBS to achieve the concentrations determined in optimization process

1. Anecdotally, 20μL of EthD-1 and 5μL of calcein AM in 10mL of PBS gives concentrations of 4μM and 2μM, respectively,
and is suitable for 3T3 cells

2. Homogenize the staining solution by inverting the tube gently several times
3. Remove media from cell-laden hydrogels and wash with PBS

1. Do 3-5 5min washes
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4. Add 200μL of staining solution directly to the hydrogels
5. Cover with aluminum foil and let it incubate for 30 minutes at room temperature
6. Image the cells under a fluorescence microscope

1. Dim the lights in the working space and keep the gels covered whenever not imaging
2. Use the FITC/GFP filter for calcein-AM (live cells)
3. Use the TRITC/RFP filter for ethidium homodimer-1 (dead cells)

Tips:

If you have extracellular fluorescence, do additional and/or longer washes with PBS prior to staining because media can have
esterases which hydrolyze the calcein AM to cause fluorescence

Calcein AM is calcein acetoxymethyl ester, and it functions by permeating live cell plasma membranes and then getting
hydrolyzed by intracellular esterases which releases the fluorescent calcein

Be sure to dim the lights of the work space and have cells covered in foil when not actively adding something or imaging
The fluorescent dyes are photosensitive

Conclusions/action items:

Use this protocol to image the fibroblasts encapsulated in GelMA hydrogels. Use the Cell Viability Image Analysis protocol to analyze the captured
fluorescent images
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Nick Herbst/Design Ideas/03/12/2024 Improved LIVE/DEAD Staining Protocol 143 of 149



 03/20/2024 Cell Viability Image Analysis Protocol

Loading [MathJax]/extensions/Safe.js

Nick Herbst/Design Ideas/03/20/2024 Cell Viability Image Analysis Protocol 144 of 149

https://www.labarchives.com/


Title: Cell Viability Image Analysis Protocol

Date: 03/20/2024

Content by: Nick Herbst

Present: Nick Herbst

Goals: Write step-by-step protocol for using ImageJ to analyze the LIVE/DEAD staining images to quantify cell viability

Content:

Materials: 

Computer
ImageJ software with Bio-Formats plugin package
Fluorescent LIVE/DEAD staining images

Methods:

1. Capture a fluorescent image and save the file with both the green (live) and the red (dead) channels

1. If a Nikon fluorescence microscope was used, the file will save as a .nd2 \
2. Open the file in ImageJ

1. File > Open > select the .nd2 file
2. In the Bio-Formats Import Options window, set “View stack with:” to “Hyperstack” and “Color mode:” to “Default”
3. Click “OK”

3. Split the image such that each channel is its own image

1. Image > Color > Split Channels
2. Close the blue channel since only the green and red channels will be used

4. Change the images’ type

1. Image > Type > 8-bit
5. Eliminate some background noise by adjusting the brightness and contrast

1. Image > Adjust > Brightness/Contrast
2. A window will pop up with a pixel intensity histogram

1. Move the “Minimum” slider to the right until the image looks cleaner without losing any important signal
2. If necessary, move the “Maximum” slider to the left to increase the intensity of the staining
3. When done, click “Apply”

3. Repeat B/C adjustment for the other image
4. Keep B/C settings constant between different images of the same channel

1. All green images should have same settings and all red images should have same settings, but green and
red images don't have to have the same settings

6. Convert the gray-scaled images into binary images via Thresholding

1. Image > Adjust > Threshold

1. Make sure dropdown menus say “Default” and “Red” and that “Dark background” is checked
2. Move the top slider (the left bound of the the threshold) so that only the stained cells are highlighted in red
3. Thresholding is a critical step

1. Too high of a threshold results in losing a lot of signal
2. Too low of a threshold will fuse cells close to each other and include background noise, making counting

more difficult
4. Click “Apply” to get a binary thresholded image
5. Repeat thresholding for the other image

7. On both images, separate fused cells

1. Process > Binary > Watershed
8. Set up the measurements window

1. Analyze > Set Measurements
2. Make sure “Area” is checked
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3. Click “OK”
9. Establish inclusion criteria for analysis

1. Analyze > Analyze Particles
2. Check “Add to Manager” and “Include holes”
3. Set “Size” to “0-Infinity” and “Circularity” to “0.00-1.00”
4. Click “OK”
5. With the ROI Manager open, click on a ROI that is the smallest but is still clearly a stained cell, then click “Measure” in the

window to get its area in μm2

6. Record this area, then click “Delete” to delete all ROIs from the manager
7. Repeat this process for the other image

1. Dead cells are smaller than live cells, so you cannot use the same minimum area for both images
10. Obtain stained cell counts for each image

1. Once again, go to Analyze > Analyze Particles
2. Check “Summarize” and “Include holes”
3. Set “Circularity” to “0.00-1.00”
4. Set “Size” such that the minimum is slightly smaller than the area that was recorded from the previous step and the

maximum is “Infinity”
5. Click “OK”
6. In the Summary window that pops up, record the value in the “Count” column

1. This is the number of stained cells for that particular channel
7. Repeat this process for the other image

11. Calculate the percentage of live cells to obtain cell viability

1. % Live = (Countgreen / (Countgreen + Countred)) * 100

1. Countgreen = number of live cells stained with calcein AM in the green channel

2. Countred = number of dead cells stained with ethidium homodimer-1 in the red channel

Conclusions/action items:

Use this protocol to analyze the captured fluorescent images
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 01/26/2023 Prior Completed Trainings

Title: Prior Completed Trainings

Date: 01/26/2023

Content by: Nick Herbst

Present: Nick Herbst

Goals: Provide proof of training that was completed in prior semesters

Content:

Conclusions/action items:

- I have completed all necessary training for use of the TEAM Lab and the Teaching Lab

- I can get additional qualifications for the TEAM Lab/Makerspace if I want/need to
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 2014/11/03-Entry guidelines

Use this as a guide for every entry

Every text entry of your notebook should have the bold titles below.
Every page/entry should be named starting with the date of the entry's first creation/activity, subsequent material from future dates can
be added later.

You can create a copy of the blank template by first opening the desired folder, clicking on "New", selecting "Copy Existing Page...", and then select
"2014/11/03-Template")

Title: Descriptive title (i.e. Client Meeting)

Date: 9/5/2016

Content by: The one person who wrote the content 

Present: Names of those present if more than just you (not necessary for individual work)

Goals: Establish clear goals for all text entries (meetings, individual work, etc.).

Content:

Contains clear and organized notes (also includes any references used)

Conclusions/action items:

Recap only the most significant findings and/or action items resulting from the entry.
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 2014/11/03-Template

Title: 

Date: 

Content by: 

Present: 

Goals: 

Content:

 

Conclusions/action items:

 

John Puccinelli - Nov 03, 2014, 3:20 PM CST
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